
Release Notes



Legal Notice

Autodesk® Maya® 2008

© 2007 Autodesk, Inc.  All rights reserved.  Except as otherwise permitted 
by Autodesk, Inc., this publication, or parts thereof, may not be reproduced in 
any form, by any method, for any purpose.

Certain materials included in this publication are reprinted with the permission 
of the copyright holder.

Graph Layout Toolkit © Copyright 1992-2003 Tom Sawyer Software, Berkeley, 
California. All rights reserved.

Mozilla Open Source Project © Copyright 1998-2004 by Contributors to the 
Mozilla codebase under the Mozilla Public License. Source code may be found 
at http://www.mozilla.org/source.html. The Mozilla software is distributed under 
the Mozilla Public License on an "AS IS" basis, WITHOUT WARRANTY OF 
ANY KIND. The Mozilla Public License may be found at www.mozilla.org/MPL/. 
All rights reserved.

Portions relating to JPEG © Copyright 1991-1998 Thomas G. Lane. All rights 
reserved. This software is based in part on the work of the Independent JPEG 
Group.

Portions of the subdivision surface implementation technology are protected by 
U.S. patents 6,037,949, 6,222,553, 6,300,960, and 6,489,960 and used under 
license from Pixar.

Trademarks
The following are registered trademarks or trademarks of Autodesk, Inc., in the 
USA and other countries: 3DEC (design/logo), 3December, 3December.com, 
3ds Max, ActiveShapes, Actrix, ADI, Alias, Alias (swirl design/logo), 
AliasStudio, Alias|Wavefront (design/logo), ATC, AUGI, AutoCAD, AutoCAD 
Learning Assistance, AutoCAD LT, AutoCAD Simulator, AutoCAD SQL 
Extension, AutoCAD SQL Interface, Autodesk, Autodesk Envision, Autodesk 
Insight, Autodesk Intent, Autodesk Inventor, Autodesk Map, Autodesk 
MapGuide, Autodesk Streamline, AutoLISP, AutoSnap, AutoSketch, AutoTrack, 
Backdraft, Built with ObjectARX (logo), Burn, Buzzsaw, CAiCE, Can You 
Imagine, Character Studio, Cinestream, Civil 3D, Cleaner, Cleaner Central, 
ClearScale, Colour Warper, Combustion, Communication Specification, 
Constructware, Content Explorer, Create>what's>Next> (design/logo), Dancing 
Baby (image), DesignCenter, Design Doctor, Designer's Toolkit, DesignKids, 
DesignProf, DesignServer, DesignStudio, Design|Studio (design/logo), Design 
Your World, Design Your World (design/logo), DWF, DWG, DWG (logo), DWG 
TrueConvert, DWG TrueView, DXF, EditDV, Education by Design, Extending 
the Design Team, FBX, Filmbox, FMDesktop, Freewheel, GDX Driver, Gmax, 
Heads-up Design, Heidi, HOOPS, HumanIK, i-drop, iMOUT, Incinerator, 
IntroDV, Inventor, Inventor LT, Kaydara, Kaydara (design/logo), LocationLogic, 
Lustre, Maya, Mechanical Desktop, MotionBuilder, ObjectARX, ObjectDBX, 
Open Reality, PolarSnap, PortfolioWall, Powered with Autodesk Technology, 
Productstream, ProjectPoint, Reactor, RealDWG, Real-time Roto, Render 
Queue, Revit, Showcase, SketchBook, StudioTools, Topobase, Toxik, Visual, 
Visual Bridge, Visual Construction, Visual Drainage, Visual Hydro, Visual 
Landscape, Visual Roads, Visual Survey, Visual Syllabus, Visual Toolbox, 
Visual Tugboat, Visual LISP, Voice Reality, Volo, and Wiretap. 

The following are registered trademarks or trademarks of Autodesk Canada 
Co. in the USA and/or Canada and other countries: Backburner, Discreet, Fire, 
Flame, Flint, Frost, Inferno, Multi-Master Editing, River, Smoke, Sparks, Stone, 
Wire.

mental ray is a registered trademark of mental images GmbH licensed for use 
by Autodesk, Inc.  Adobe, Illustrator and Photoshop are either registered 
trademarks or trademarks of Adobe Systems Incorporated in the United States 
and/or other countries. The Ravix logo is a trademark of Electric Rain, Inc. 
"Python" and the Python logo are trademarks or registered trademarks of the 
Python Software Foundation. All other brand names, product names or 
trademarks belong to their respective holders.

Disclaimer  
THIS PUBLICATION AND THE INFORMATION CONTAINED HEREIN IS 
MADE AVAILABLE BY AUTODESK, INC. "AS IS."  AUTODESK, INC., 
DISCLAIMS ALL WARRANTIES, EITHER EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE 
REGARDING THESE MATERIALS. 

Published by: 
Autodesk, Inc. 
111 Mclnnis Parkway 
San Rafael, CA 94903, USA

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

All use of this Software is subject to the terms and conditions of the Autodesk 
End User License Agreement accepted upon installation of this Software and/
or packaged with the Software.

Patents
Protected by one or more of U.S. Patent Nos.  6,384,835, 6,356,271, 
6,204,860, 6,549,212, 6,414,700, 6,915,492, 6,348,924, 6,462,740, 5,889,528, 
6,025,852, 5,999,195, 6,130,673, 6,389,154, 6,553,337, 6,850,638, 6,525,735, 
7,034,824, 6,232,980, 5,852,450, 5,990,908, 6,363,503, 7,168,012, 6,888,542, 
5,287,408, 6,317,128, 5,764,233, 6,037,948, 6,246,416, 6,266,071, 5,847,716, 
7,139,444, 6,859,202, 6,798,416, 6,118,427, 5,809,219, 6,211,882, 5,808,625, 
5,929,864, 5,818,452, 5,689,667, 5,926,178, 6,618,063; and patents pending.
 

Third-Party Software Credits and Attributions
Graph Layout Toolkit © Copyright 1992-2003 Tom Sawyer Software, Berkeley, 
California. All rights reserved. 

Mozilla Open Source Project © Copyright 1998-2004 by Contributors to the 
Mozilla codebase under the Mozilla Public License. Source code may be found 
at http://www.mozilla.org/source.html. The Mozilla software is distributed under 
the Mozilla Public License on an "AS IS" basis, WITHOUT WARRANTY OF 
ANY KIND. The Mozilla Public License may be found at www.mozilla.org/MPL/. 
All rights reserved. 

Portions relating to JPEG © Copyright 1991-1998 Thomas G. Lane. All rights 
reserved. This software is based in part on the work of the Independent JPEG 
Group. 

Portions relating to TIFF © Copyright 1988-1997 Sam Leffler. © Copyright 
1991-1997 Silicon Graphics, Inc. All rights reserved. Permissions to use, copy, 
modify, distribute, and sell this software and its documentation for any purpose 
is hereby granted without fee, provided that (i) the above copyright notices and 
this permission notice appear in all copies of the software and related 
documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not 
be used in any advertising or publicity relating to the software without the 
specific, prior written permission of Sam Leffler and Silicon Graphic.
THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF 
ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT 
LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE.  IN NO EVENT SHALL SAM LEFFLER OR 
SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTIAL, 
INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY 
DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF 
DAMAGE, AND ON ANY THEORY OF LIABIBITLY, ARISING OUT OF OR IN 
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. 

Portions relating to the implementation of the Edge Detection and Image 
Segmentation (EDISON) System are provided "AS IS". More information may 
be found at http://www.caip.rutgers.edu/riul/research/code.html.
 

Portions of the subdivision surface implementation technology are protected by 
U.S. patents 6,037,949, 6,222,553, 6,300,960, and 6,489,960 and used under 
license from Pixar. 

Portions relating to OpenEXR Copyright © 2002, Industrial Light & Magic, a 
division of Lucas Digital Ltd. LLC All rights reserved. Redistribution and use in 
source and binary forms, with or without modification, are permitted provided 
that the following conditions are met: Redistributions of source code must 
retain the above copyright notice, this list of conditions and the following 
disclaimer. Redistributions in binary form must reproduce the above copyright 
notice, this list of conditions and the following disclaimer in the documentation 
and/or other materials provided with the distribution. Neither the name of 
Industrial Light & Magic nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior 
written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT 
HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT 
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY 
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT 
OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.



Table of Contents
Table of Contents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3

1 Introduction to release notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9

Release notes Autodesk Maya 2008 release notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

2 What’s fixed in Autodesk Maya 2008 . . . . . . . . . . . . . . . . . . . . . . . . . . . . .11

Release notes What is What’s Fixed? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

What’s fixed in general  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

What’s fixed in Modeling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

What’s fixed in Animation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

What’s fixed in Deformers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

What’s fixed in Character setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

What’s fixed in Rendering  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

mental ray for Maya rendering  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Software rendering  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Hardware rendering . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

What’s fixed in Fur. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

What’s fixed in Artisan, 3D Paint, and Paint Effects . . . . . . . . . . . . . . . . . . . . 15

What’s fixed in Dynamics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

What’s fixed in Fluid Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

What’s fixed in nCloth . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

3 Basic interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .19

Release notes General UI limitations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

Japanese user interface. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

4 Animation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .25

Release notes General animation limitations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

Animation playblast limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

Dope Sheet limitations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

Graph Editor limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

Trax Editor limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

Path animation limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
Autodesk Maya 2008 Release Notes
3



Table of Contents
5 Character setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .31

Release notes General character setup limitations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

Skeleton and Inverse Kinematics limitations . . . . . . . . . . . . . . . . . . . . . . . . . 31

Skinning limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

6 Deformers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .33

Release notes General deformer limitations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

7 NURBS modeling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .35

Release notes NURBS modeling limitations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Create Adobe Illustrator Object limitations. . . . . . . . . . . . . . . . . . . . . . . . . . . 35

8 Subdivision Surfaces  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .37

Release notes Subdivision Surfaces limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

9 Polygons and games . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .39

Release notes General polygon and games limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

10 Artisan, 3D Paint, and Paint Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .45

Release notes Artisan limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

3D Paint Tool limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

Paint Effects limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

11  Dynamics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .51

Release notes Dynamics limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

12 Rendering . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .55

Release notes General rendering limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

Interactive scene view limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

Camera limitations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

Render Layers/Passes limitations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

Raytracing limitations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

Rendering workflow issues . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
Autodesk Maya 2008 Release Notes 

4



Table of Contents
Maya Software rendering limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

Maya Software IPR Rendering limitations. . . . . . . . . . . . . . . . . . . . . . . . . . 60

mental ray for Maya rendering limitations  . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

Unsupported features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

Known limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

mental ray satellite rendering limitations . . . . . . . . . . . . . . . . . . . . . . . . . . 68

mental ray for Maya rendering tips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

Hardware rendering limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

Known limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

Vector rendering limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

Hardware shading limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

Maya Software plug-in limitations in hardware shading . . . . . . . . . . . . . . . . 72

Texturing limitations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

Photoshop integration limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

Rendering optimizations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

Technical notes (for scenes created using Maya 6.5 or earlier) . . . . . . . . . . . . 74

Changes to render globals nodes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

13 Maya nCloth  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .79

Release notes General nCloth limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79

14 Maya Fur . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .83

Release notes General Fur limitations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83

Limitations when rendering Fur in the Maya Software renderer  . . . . . . . . . . . . 84

Limitations when rendering Fur in mental ray for Maya . . . . . . . . . . . . . . . . . . 85

15 Maya Live . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .87

Release notes General scene limitations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87

Setup limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87

Track limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88

Solve limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89

16 Maya Fluid Effects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .91

Release notes Fluid Effects limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
Autodesk Maya 2008 Release Notes
5



Table of Contents
17 Maya Hair  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .99

Release notes Hair limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99

18 Maya Toon. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .103

Release notes Toon limitations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103

19 Miscellaneous and translators . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .105

Release notes General Maya limitations & workarounds. . . . . . . . . . . . . . . . . . . . . . . . . . . 105

Translator limitations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109

MayaToAlias and StudioImport limitations . . . . . . . . . . . . . . . . . . . . . . . . . . 109

Obj limitations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112

OpenFlight limitations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112

IGES import and export  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113

Miscellaneous translators  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113

Platform-specific limitations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113

Maya for Windows limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113

Maya for Linux limitations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113

Maya for Mac OS X limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116

20 Maya commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .123

Release notes Maya commands limitations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123

General  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123

MEL . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123

Python  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124

21 File formats. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .127

Release notes File formats limitations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

File referencing limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

22 Utilities and peripherals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .133

Release notes RIB Export limitations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133

23 API and Devkit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .135
Autodesk Maya 2008 Release Notes 

6



Table of Contents
Release notes API and Devkit limitations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135

MPxSurfaceShape related problems . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142

24 Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .143

Release notes Maya Help limitations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143

Index. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .145
Autodesk Maya 2008 Release Notes
7



Table of Contents
Autodesk Maya 2008 Release Notes 

8



1 Introduction to release notes
Release 
notes

Autodesk Maya 2008 release notes
The Maya 2008 release notes contain known limitations and workarounds for 
Maya and is organized into chapters according to Maya’s functionality. 

To find out which limitations were fixed for this release, see the following:

• ”What’s fixed in general” on page 11

• ”What’s fixed in Modeling” on page 11

• ”What’s fixed in Character setup” on page 12

• ”What’s fixed in Rendering” on page 13
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2 What’s fixed in Autodesk 
Maya 2008
Release 
notes

What is What’s Fixed?
In Autodesk® Maya® 2008, we've corrected some problems in the Maya 
software that have been reported by our customers. For new features and 
improvements, see “Overview of What’s New” in the What’s New in Maya guide.

The following sections list the software limitations that were fixed in Maya 2008.

What’s fixed in general
The following lists general limitations that were fixed in Maya 2008.

Script Editor slowing down batch render
In previous versions of Maya, having the Script Editor open during a batch render 
would slow down the render considerably. This problem has been fixed. 

Font size too small on Windows XP Chinese environment
In Maya 8.5 the default font size for many items within the graphical user 
interface when running in a Chinese language environment on Windows XP was 
too small to be legible. This has been fixed. 

What’s fixed in Modeling
The following lists modeling limitations that were fixed for Maya 2008.

Map Borders options for Smooth incorrect
In Maya versions 8.0 and 8.5 the Map Borders options in the Smooth options 
window (Mesh > Smooth) were incorrectly mapped to their function. This problem 
has been fixed. 

What’s fixed in Animation
The following lists Dynamics limitations that were fixed for Maya 2008.

Graph Editor and object selection
Selection speed of objects when the Graph Editor is open has been improved. 

animEngine Example improvement
The animEngine devkit example has been improved so that the "stepped next" 
(global) curve and other weighted curves evaluate correctly 
Autodesk Maya 2008 Release Notes
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2 | What’s fixed in Autodesk Maya 2008
Release notes > What’s fixed in Deformers
Motion Paths and object location
Motion paths in a scene now appear correct relative to the world space location 
of the object they were created for. 

Smooth skin on substitute geometry
When attempting to perform a Skin > Edit Smooth Skin > Substitute Geometry 
operation, Maya would occasionally exit prematurely when attempting to fix bad 
verticies. This has been fixed. 

What’s fixed in Deformers
The following lists deformer limitations that were fixed for Maya 2008.

Soft modification color feedback on file references
The color feedback that appears when a soft modification deformer is applied to 
an object does not appear on objects that are file references. This has been 
fixed. 

Wrap deformer performance
Wrap deformer performance has been enhanced. 

What’s fixed in Character setup
The following lists Character setup limitations that were fixed for Maya 2008.

Smooth skin performance
Smooth Skin > Add Influence has been enhanced. The performance of adding 
polygonal influences has been improved. The performance of adding a zero-
weighted influence has been improved as well. 

Deleting a character node
The performance of deleting a large character node has been improved.

FBIK and rotations
HIK Effector's Pre-rotation is now treated the same as jointOrient for orient and 
parent constraints. Now orient or parent constraining an object to an FBIK 
effector no longer gives the object an extra rotation. 
Autodesk Maya 2008 Release Notes
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2 | What’s fixed in Autodesk Maya 2008
Release notes > What’s fixed in Rendering
What’s fixed in Rendering
The following lists rendering limitations that were fixed for Maya 2008.

mental ray for Maya rendering

Camera environment settings now respected when IBL node has 
primary visibility turned off

In previous versions of Maya, adding an IBL node to your scene with primary 
visibility turned off results in a black background regardless of your camera 
environment settings. This has been fixed for Maya 2008. 

Lightlinking is obeyed when baking vertex color with IBL

In previous releases of Maya, lightlinking appeared to be ignored when vertex 
baking is used with IBL. This has now been fixed. 

Selecting surfaces as source meshes when creating mental ray transfer 
maps

In previous releases of Maya, when creating mental ray transfer maps, all 
meshes in your scene that are not selected as target meshes were automatically 
loaded as source meshes. This has now been fixed. 

IPR now correctly lights mental ray shaders

Previously, if your scene includes a mental ray shader, and you select an area to 
auto-render in the IPR, and then update the mental ray shader, mental ray 
shaders would render black. This has now been fixed.  

Volume method for fur rendering now produces shadows correctly

Previously, if you set the Fur Shader to Volume In the Fur Render Settings (Fur > 
Fur Render Settings), the fur does not render with shadows if the scene uses 
shadow maps. This has now been fixed.  

Rendering final gather in a scene created using Maya version 7.0 now 
works correctly with Maya 2008

Previously, when you used Maya 8.5 to render scenes with final gather that was 
created using Maya version 7.0 or earlier, artifacts much like polka dots may 
appear. This has now been fixed.

mental ray for Maya supports DDS textures as input

Previously, mental ray for Maya did not support input textures in the .dds format. 
This has now been fixed. 

Command line rendering now respects batch rendering options

Command line rendering now respects the user preferences you set in ”Render > 
Batch Render > r” on page 247. 
Autodesk Maya 2008 Release Notes
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2 | What’s fixed in Autodesk Maya 2008
Release notes > What’s fixed in Rendering
PSD textures now update in IPR for mental ray for Maya

Previously, when you update the image file name for a PSD File texture and press 
the Reload button, the PSD texture does not update in IPR for mental ray for 
Maya. This has now been fixed. 

mental ray IPR now correctly removes default light

Previously, if you start mental ray IPR on a scene that does not contain lights, IPR 
correctly uses the default light. However, IPR fails to remove this default light 
after you add a new light. This has now been fixed. 

mental ray IPR can now switch between different cameras without 
restarting

Previously, when you switch between different cameras in the IPR menu in mental 
ray for Maya, the IPR restarts itself. This has now been fixed and you can switch 
between different cameras in IPR without triggering a scene translation. 

IPR respects the Preview Final Gather Tiles setting in the Render 
Settings window

If the Preview Final Gather Tiles setting is enabled in the Render Settings: mental 
ray tab, then IPR enables and passes the preview final gather tiles to be 
displayed in the Render View for any user action that triggers an update, for 
example, a parameter change or a scene change. These tiles appear as soon as 
final gather is enabled with the IPR quality set to Render Settings. They provide 
quick feedback on final gather point computation prior to final rendering of the 
pixels. 

mental ray fur rendering with the Rasterizer and Full Motion Blur

Previously, mental ray did not render fur correctly when the Rasterizer was used 
and Motion Blur was set to Full. This has now been fixed. 

Alpha Is Luminance now off by default for layered textures

The default value for Alpha Is Luminance for layered textures is now off. 

All shape nodes now get user data related to color sets and UV sets

By default, all shape nodes will get user data related to color sets and UV sets. 
To turn this off, disable the Export Custom Data option under the Customization 
section of the Render Settings: mental ray tab. 

Phenomena files can now use an include statement without an 
absolute path

Previously, an '$include' statement would only work in a phenomenon .mi file if it 
includes an absolute path. This has now been fixed. 

Transfer map tool now remembers source and target meshes

The Transfer map tool (Lighting/Shading > Transfer Maps) now remembers the 
last set of source and target objects that were baked. 
Autodesk Maya 2008 Release Notes
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2 | What’s fixed in Autodesk Maya 2008
Release notes > What’s fixed in Fur
Initial render in mental ray now works on Windows Vista

Previously, on the 32-bit Windows Vista operating system, the initial render in 
mental ray fails with a mi_openexer.dll error. This has now been fixed. 

Software rendering

Matte Opacity material attribute fixed for Maya Software renderer

Maya 2008 fixes the behaviour of the Matte Opacity material attribute for the 
Maya Software renderer. In rare cases, this fix may break backward compatibility. 
To revert to the old behavior, enter the following command in the Script Editor: 

setAttr defaultRenderGlobals.matteOpacityUsesTransparency 0; 

Hardware rendering

High Quality Render and Isolate Select

Previously, Isolate Select was supported with High Quality Render at the object 
level. Now, it is also supported at face component level. 

What’s fixed in Fur
The following lists Fur limitations that were fixed for Maya 2008.

Fur rendering over a network
Scenes rendered involving fur and dense polygons now render faster over a 
network. 

What’s fixed in Artisan, 3D Paint, and Paint Effects
The following lists Artisan, 3D Paint, and Paint Effects limitations that were fixed 
for Maya 2008.

Displacement display on Artisan brush
When sculpting with Artisan the displacement arrow on the brush now remains on 
screen after the initial stroke. 

Assign color attribute for 3D paint tool
Assigning a texture file to the color attribute of the assign shader material will 
connect to the color attribute, rather than the transparency attribute.  

Brush display and CTRL key
When using the CTRL hotkey in Artisan sculpting to toggle between push and pull 
the vector displayed on the brush to indicate max displacement now changes 
appropriately. 
Autodesk Maya 2008 Release Notes
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2 | What’s fixed in Autodesk Maya 2008
Release notes > What’s fixed in Artisan, 3D Paint, and Paint Effects
Paint vertex colors on intermediate objects
Painting vertex colors on intermediate objects now renders properly. 

Sculpting and switching using the Outliner
When using the Smooth brush to sculpt a polygon model while simultaneously 
using the Outliner to switch between meshes, Maya would exit prematurely. This 
has been fixed. 

Paint Fur Attributes Tool and renaming
When painting fur attributes with the Paint Fur Attributes tool followed by 
renaming the affected mesh, Maya would exit prematurely. This has been fixed. 

Sculpt Geometry on intermediate objects
Sculpt Geometry on intermediate objects now renders properly. 

Paint Blur and using Screen Projection
When using the Shift-key to paint Blur and then attempting to activate Screen 
Projection, Maya would exit prematurely. This has been fixed. 

Rapidly increasing the magnitude level
Occasionally when using the Sculpt Polygon Tool in Pull mode and using the ‘m’ 
key to increase the magnitude, Maya would exit prematurely if the magnitude was 
increased too quickly. This has been fixed. 

Using the Eye Dropper tool on a surface with no texture
When using the Texture 3D Paint Tool and then attempting to use an Eye Dropper 
tool from a Color Chooser on a surface with no texture, Maya would exit 
prematurely. This has been fixed. 

Remove operation
When using the Remove operation of the Paint Vertex Color options as the first 
operation applied to an object, Maya would exit prematurely. This has been fixed. 

Mirroring extremely small brushes
When using the Mirror option with very small brush sizes, Maya would stop for 
long periods of time before resuming. This has been fixed. 

Deleting a brush node
When deleting a brush node from the Hypergraph:Connections editor after having 
just drawn in the viewport, Maya would exit prematurely. This has been fixed. 
Autodesk Maya 2008 Release Notes
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2 | What’s fixed in Autodesk Maya 2008
Release notes > What’s fixed in Dynamics
What’s fixed in Dynamics
The following lists Dynamics limitations that were fixed for Maya 2008.

Enable Texture Rate and Need Parent UV
When Enable Texture Rate was turned on and Need Parent UV was turned off, 
Maya would exit prematurely. This has been fixed.

Rigid Body Damp Attributes
Rigid Body Damp attribute can now be adjusted to values greater than 10 with 
the slider.

What’s fixed in Fluid Effects
The following lists Fluid Effects limitations that were fixed for Maya 2008.

Fuel options above zero
When scenes containing fluids in which the fuel attributes Ignition Temperature 
and Light Released were both set to a value above zero, Maya would exit 
prematurely. This has been fixed. 

What’s fixed in nCloth
The following lists nCloth limitations that were fixed for Maya 2008.

Damping a Dynamic Constraint
Increasing the damp setting of a Dynamic Constraint node now produces 
predictable results.

nCloth rendering and licensing
When rendering a scene with caches and nCloth objects, Maya security would 
require a fluidsimf license. This has been fixed so this license is no longer 
required. 

Initial State > Set from Current and velocities
Applying an Initial State > Set from Current on an nCloth object travelling at some 
velocity now produces predictable results. 

nCache speed predictability
When rendering multiple cached nCloths, Maya evaluated the first object in a 
different way than the others. This has been fixed.  
Autodesk Maya 2008 Release Notes
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2 | What’s fixed in Autodesk Maya 2008
Release notes > What’s fixed in nCloth
nCache and velocities
When caching multiple nCloth objects with velocities and then playing or 
appending from the end of the cache, the first object responded predictably while 
the subsequent objects’ velocities reset to 0. This has been fixed. 
Autodesk Maya 2008 Release Notes
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3 Basic interface
Release 
notes

General UI limitations 
The following limitations and workarounds relate to general UI issues. For 
platform-specific UI issues, see:

• ”Maya for Windows limitations” on page 113

• ”Maya for Linux limitations” on page 113

• ”Maya for Mac OS X limitations” on page 116

Camera overlays shift when using the ViewCube
Tumbling the perspective view using the ViewCube causes the Resolution 
Gate, Film Gate, Safe Action, Field Chart, and Safe Title camera overlays to 
shift position unexpectedly. 

Workaround

Tumble the view using the Alt + left-mouse button.

Maya 3D Shockwave Exporter
Maya 3D Shockwave Exporter is no longer provided as part of Maya. 

Problems loading some very large files 
We made speed improvements to polygon drawing in Maya 6.5 that involve 
using a polygon draw cache. When loading certain very large files in Maya 
6.5, the polygon draw cache of Maya may cause the memory usage of Maya 
to exceed the memory available to the application on your system, resulting 
in instability.

(Note: The 64-bit version of Maya on Windows and Linux provides enough 
memory space that this issue should not arise.)

If you encounter this problem using Windows XP on a 32-bit system, we 
suggest you increase the application memory limit of Maya; for instructions 
on how to do this, see ”Set Maya to use maximum memory (increase the 
Virtual Memory limit)” on page 185 in the Basics book.

As well, we have added a mechanism to disable the polygon draw cache so 
that you can more easily load very large files. There is an environment 
variable called MAYA_DISABLE_POLYGON_DRAW_CACHE. Set it to 1 to disable 
the polygon draw cache.

If you disable the polygon draw cache, interactive draw performance will be 
slower. We recommend that you not leave this environment variable set to 1, 
but instead set it only for working on files that show this problem. 
Autodesk Maya 2008 Release Notes
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3 | Basic interface
Release notes > General UI limitations
Maya 6.0 and Windows XP SP 2
If you’re still running Maya 6.0, you may experience problems under Windows 
XP SP 2 where Maya may fail to start. This is a known issue with Windows; 
please see:

support.microsoft.com/default.aspx?kbid=842242&product=windowsxpsp2

Tear-off menus and Windows XP
Tear-off menus in Maya have display problems when using Windows XP Style 
UI schemes. 

Workaround

Select Start > Control Panel and double-click the Display icon. Select the 
Appearance tab and change UI scheme to Windows Classic.

Hotkeys disabled when using Attribute Editor in main window
If you have the Attribute Editor open in the main window, and you click it, type 
in a new value, and then press Enter, the keyboard focus stays in the 
Attribute Editor. This means your hotkeys will not work until you return focus 
to the modeling window. 

Workaround

To get the focus back into the modeling window without changing anything 
else, move the mouse over the window and click with the middle mouse 
button. 

Speeding up interactive performance on Linux machines
On Linux machines, you can speed up Maya’s interactive performance by 
closing or hiding the Attribute Editor when you are not using it. 

Using the grid in perspective view
If you are working in non-default units, you may not see the grid in 
perspective view when you first open a file. The problem is that the grid is 
created at the wrong size. Zooming out will show it. 

Workaround

Select Display > Grid > � and click the Reset button. Then on the view panel 
select View > Default Home.

Tearing off menus with check boxes or radio buttons
If you tear off a menu that has check boxes or radio buttons and leave it 
open, the check marks and buttons may not update. 

Workaround

Close the menu, then reopen it

Setting rotation and translation limits in the Channel Box
You cannot set rotation and translation limits in the Channel Box. 
Autodesk Maya 2008 Release Notes
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3 | Basic interface
Release notes > General UI limitations
Workaround

Use the Attribute Editor. To set the limits of many objects at once, use the All 
tab in the Attribute Spread Sheet (Window > General Editors > Attribute 
Spread Sheet).

Using torn off panels in panel layouts
Panel layouts cannot use panels that have been torn off. If you select a panel 
layout that includes a torn-off panel, Maya displays a warning that it cannot 
use the panel. Any available panel is used instead. For example, the built-in 
Persp/Outliner panel layout usually places the Outliner in the left pane and 
the Perspective view in the right pane. If you tear the Outliner off into its own 
window, a warning is issued and another panel is put in place of the Outliner.

Workaround

Once you close the tear-off panel, it can be used by panel layouts that 
include it.

Edit option menu for mode selection disabled for tools
Option windows for tools and actions include an Edit option menu at the top 
of the window that allows you to pick between tool and action modes. 
Currently, only actions can be switched to tool mode. Therefore, for tools (for 
example, Birail Surface Tool), the Edit option menu is disabled.

Non-sequential Enum values in the Channel Box
The Channel Box will sometimes incorrectly display an enumerated attribute's 
pull-down menu. Extra menu items can appear that represent the numbers in 
between non-sequential option values. 

Workaround

Specify sequential values for the options of any enumerated attributes that 
will appear in the Channel Box. For example: “solo=1:triplet=2:quintet=3”.

Field callbacks must not delete the window that contains the 
field

If the callback for a field in a window issues a deleteUI command for the 
window it is in, then Maya will suffer a fatal error. For example: 

window w; columnLayout; textField -cc "deleteUI w"; showWindow w; 

Workaround

Use the evalDeferred command. So in the previous example, change the 
textField command to:

textField -cc "evalDeferred(\"deleteUI w\")";
Autodesk Maya 2008 Release Notes
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3 | Basic interface
Release notes > General UI limitations
Selection marquee or panel contents disappear
Returning to Maya after a screen saver has been activated can, with some 
old or low-end graphics cards, cause selection marquees or panel contents to 
disappear. 

Workaround

Press the space bar or use the Panels menu to change the current panel 
configuration. All panels should now be drawing normally. To return to your 
previous configuration, either press the space bar again, or select the 
appropriate entry from the Panels menu.

Selecting components with the Lasso Tool
The Lasso Tool, when the Selection Mode is set to Object, can sometimes 
fail to select objects or highlighted components. This will typically occur when 
the lasso approaches an item of higher Selection Priority. 

Workaround

If selecting components, set the Selection Mode to Component. 

Isolate Select not working for subdivision surface vertices or 
edges

Isolate Select does not work for subdivision surface vertices or edges. 

Workaround

Isolate subdivision surface faces instead. 

Running Maya maximized blocks auto-hide task bar in 
Windows 2000 

Under Windows 2000, if you run Maya with the title bar off (Maya option) and 
maximized with Auto hide on your Taskbar (Windows options), then you won't 
be able to get your Taskbar to come up. 

Workaround

Don't use the Auto hide feature of the Windows Taskbar.

Power saver software causes problems 
If you are using power saver software or some screensavers that use 
OpenGL, Maya may shut down abnormally or cause system problems at the 
end of a Maya session or batch render. This problem has been reported on 
64-bit systems.

Workaround

Disable power saver software when working with Maya. 
Autodesk Maya 2008 Release Notes
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3 | Basic interface
Release notes > Japanese user interface
Japanese user interface

Custom install paths
It is recommended that custom install paths for Maya be specified using only 
ASCII characters. That is, typing multibyte text as part of the install path may 
produce unexpected results. 

Multibyte node names and attributes
Maya does not support multibyte text when specifying node names and 
attributes. 

Workaround

Do not use multibyte text for node names or attributes; only single-byte 
characters form valid node and attribute names.

Panel names appear in English when launching Maya files 
earlier than version 8.5

When loading pre-8.5 Maya files in the Maya 8.5 Japanese version, panel 
names may appear in English. 

Workaround

Save the scene in Maya 8.5 and then re-open it to reset the panel names to 
appear in Japanese.

Syntax errors when using localized version of Maya
While most commands in Maya deal with multibyte text correctly, it is 
possible that using multibyte text in certain text fields of the user interface 
may result in a syntax error. 

Workaround

Remove the multibyte characters from the text field and try again.

Scripting using multibyte text in Maya
Localized text in MEL that uses multibyte characters is only accepted when 
placed within quotation marks (“textstring”). Text strings comprised of 
multibyte characters not placed within quotation marks produce a syntax 
error when executed as part of a MEL command. 

User interface panel/configuration name limitations
MEL and Python scripts that use English language panel/configuration names 
must be updated before they'll execute correctly on a localized version of 
Maya. 

Workaround

Change the syntax of the script using the example below as a guide. For 
example, replace lines like: 
 

Autodesk Maya 2008 Release Notes
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3 | Basic interface
Release notes > Japanese user interface
getPanel -withLabel "Graph Editor" 
 

with this: 
 

getPanel -withLabel (localizedPanelLabel("Graph Editor"))

Multibyte text when setting environment variables
Using the Maya.env file to initialize environment variables with multibyte 
characters may result in incorrect behavior or character corruption. 

Workaround

Do not use multibyte text when initializing environment variables through 
Maya.env.

Multibyte text for defining name clash prefixes for file 
referencing

Maya does not support multibyte text when defining name clash prefixes for 
file references. 

Workaround

Do not use multibyte text for name clash prefixes; only single-byte characters 
work.
Autodesk Maya 2008 Release Notes
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4 Animation
Release 
notes

General animation limitations
The following limitations and workarounds relate to general animation issues in 
Autodesk® Maya®.

Caching objects with changing topology
Caching produces useful results on objects whose topology does not change 
over time. Some animated modeling construction history operations result in 
topology changes over time. While you can create a cache for these objects, 
it may distort the object during playback since a constant topology is 
assumed.

Cut Keys with Shape option only works when shape is 
expanded in Channel Box

You can only cut keys from an object if its shapeNode it is expanded in the 
Channel Box. 

Workaround

To Cut Keys on Shapes, you need to have the Shapes option enabled, and 
you must also have the shape node expanded in the Channel Box.

Pair blend/quaternion animation curve combination can cause 
jump on creation 

If your rotation curves default to synchronized quaternion interpolation, 
setting a key on a constrained object can cause the orientation of the object 
in question to jump. 

Workaround

Re-enter the rotation values you wanted to key to, and re-key the rotation 
channels.

Quaternion animation curves not correctly converted to Trax 
clip

Workaround

Quaternions in clips will only work properly if all three rotate channels are 
included in the character. This happens automatically if you use Maya's 
automatic character creation. However, if you create your character manually, 
you need to include all three rotate channels in the character if you want to 
use quaternions.
Autodesk Maya 2008 Release Notes
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4 | Animation
Release notes > General animation limitations
Synchronized quaternion curve
For synchronized quaternion curve, all three rotation channels on the object 
should exist at all times. Deleting one of the rotation channels will have 
unexpected results, such as changing the animation on the remaining 
channels. 

Workaround

Convert the curve to Euler angles before deleting the channel. Or set the 
rotation keys on the channel to a static value rather than deleting the 
channel.

Synchronized Quaternion rotation interpolation limitation
When keyframing rotations using the Synchronized Quaternion preference, 
rotations will be clamped between +/- 360 degrees. 

Unexpected behavior of animation if all three channels 
unsynchronized when modifying using the API

If you modify the keys of a synchronized animation curve (quaternion or 
synchronized Euler) using the API, you must keep all the keyframes 
synchronized on the three rotation channels. If all three rotation channels are 
not synchronized, your animation will behave unexpectedly and eventually 
crash. 

Options in option windows (Edit > Keys menu) disabled for 
current characters

When a character is current, options in several option windows are disabled. 
The options are disabled because they operate on all the attributes of the 
current character. The option windows affected are the ones under the Edit > 
Keys menu item.

Workaround 

Set the current character to None.

Ghosting and simulated objects
Attempting to apply ghosting to simulated objects such as particle 
simulations, soft bodies, rigid bodies, cloth and jiggle deformers may result 
in unpredictable reactions. 

Workaround

Create a disk cache for the simulation.

Preferred angles on joints controlled by IK handles
Using Skeleton > Set Preferred Angle on joints in a chain controlled by an IK 
Handle will appear to have no effect. 

Workaround

• Create the IK Handle after setting the preferred angles of the joints. 
Autodesk Maya 2008 Release Notes
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4 | Animation
Release notes > Animation playblast limitations
• Delete the IK Handle and then invoking "Undo" to restore yields an IK 
solution that respects preferred angle.

Deleting the top level character
If a character with subcharacters is deleted, and the subcharacters are not 
deleted, the subcharacters will no longer be recognized by the Maya UI 
because they are no longer part of the character partition. 

Workaround

Manually add the characters that are now the top-level characters into the 
characterPartition by typing:

partition -add characterPartition <subCharacterName>;

Animation playblast limitations
The following limitations and workarounds relate to the Playblast window in Maya.

Playblast escape limitation
Before you can escape from playblast you have to wait for entire sound track 
to record. 

Large imported audio files delay Playblast
The playback time of Playblast may be severely delayed in scenes with large 
imported .aiff audio files. For example, a 40MB .aiff file may cause a 20+ 
second delay between the initial command call and playback.

Workaround

View and play all (as long as your audio clips do not overlap) your loaded 
audio files from the Trax Editor or use multiple short audio files rather than 
single large audio files.

Sync problems with long aiff files
If you are playblasting sound with large negative offsets, you may encounter 
audio synchronization problems.

Workaround

Shorten your audio files so you don't need to use large negative offsets. 

Dope Sheet limitations
The following limitations and workarounds relate to the Dope Sheet in Maya.

Dope Sheet Manipulator disappears
When using the Dope Sheet manipulator, expanding or compressing any 
channels in the Dope Sheet will cause the manipulator to disappear.
Autodesk Maya 2008 Release Notes
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4 | Animation
Release notes > Graph Editor limitations
Workaround

Redo your selection to restore the manipulator.

Cut and Paste hotkeys do not use their settings from Edit > 
Copy or Edit > Paste in Dope Sheet

When using the Cut (default: Ctrl+x) or Paste (default: Ctrl+v) hotkeys with 
the Dope Sheet Manipulator, the hotkeys do not use the settings in their 
respective Dope Sheet menu option windows. Instead, they always shift your 
animation to accommodate the removal or insertion of time and keys.

Graph Editor limitations
The following limitations and workarounds relate to the Graph Editor in Maya.

Copy/paste keys in Graph Editor
When cutting and pasting keys that include multiple animation curves to 
multiple attributes, pay particular attention to the order that you select them, 
as this will impact the order in which they are pasted. 

When cutting keys from multiple attributes in the Graph Editor or Dope Sheet, 
select the attributes from the Outliner-not the view area-of the respective 
editor.

Trax Editor limitations 
The following limitations and workarounds relate to the Maya® TraxTM Editor.

Merging characters copies clips but not the blends between 
clips

Workaround

Restore the blends manually after merging. 

Clips in Trax that have the same start time or end time may 
jump

Clips in Trax that have the same start time or end time may jump when the 
clip starts/ends if there is a blend between them.

Workaround

Do one of the following:

• Modify the hold on the final clip to control how long it plays.

• Use “Merge” on the blended clips to create a single clip. 

• Create a pose that corresponds to the start or end point of the blended 
clips, then drag and drop the pose into Trax immediately before or after 
the blended clips to force the character to keep the pose before or after.
Autodesk Maya 2008 Release Notes
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4 | Animation
Release notes > Path animation limitations
Unable to create layered animation on top of a relative clip
Workaround

Merge the relative clip to replace the relative clip with an absolute clip, then 
create the layered animation on top of the absolute clip. 

Blends not working for certain clip configurations
When an absolute clip is followed by a relative clip and then blended into 
another absolute clip, the blend may behave incorrectly.

Workaround

Create a hold for the first absolute clip and drag it to the end of the relative 
clip. Blend this with the second absolute clip. You should now have the 
correct animation.

Changing animation frame rate can cause Trax time warp and 
blend problem 

If you change the animation frame rate, Trax time warps and blend curves do 
not scale properly. 

Workaround 

All time warp and blend curves must be scaled to compensate for the frame 
rate change. They are supposed to always be between 0 and 1, but when the 
frame rate changes they get scaled to fit the new frame rate. You must scale 
the curves to fit between 0 and 1 in the time range.

Parenting a Cloth object to a Trax character
When a Cloth object is parented to a Trax character, the Trax Editor will not 
evaluate Cloth correctly. 

Workaround

Select the object and cloth node and unparent them from the main 
character's hierarchy. Delete the Cloth cache and run the simulation.

Path animation limitations
The following limitations and workarounds relate to path animation in Maya.

Geometry popping out of flow lattice
If a transform object with several pieces of geometry grouped under it is 
animated with path animation, and then flow is applied with the lattice 
around the object option, occasionally some of the geometry may “pop out” 
of the flow lattice. 

Workaround

Do one of the following:
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• Set the Outside Lattice attribute for the FFD to “All” so that all the 
geometry grouped under the transform object is affected by the flow 
lattice.

• Select the base lattice of the flow’s FFD and scale it a little larger until 
the geometry “pops back” inside the flow lattice.
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General character setup limitations
The following limitations and workarounds relate to general character setup 
issues in Autodesk® Maya®.

When you delete a top-level character set, Maya no longer 
recognizes its subcharacters

If a character with subcharacters is deleted, and the subcharacters are not 
deleted, the subcharacters will no longer be recognized by the Maya UI 
because it is no longer part of the character partition. 

Workaround

Manually add the characters that are now the top-level characters into the 
characterPartition by typing: 

partition -add characterPartition <subCharacterName>;

Skeleton and Inverse Kinematics limitations
The following limitations and workarounds relate to skeleton and inverse 
kinematics issues in Maya.

Advanced twist attribute on ikSpline only works for joint 
orientation +x

The advanced twist attributes on the ikSpline solver assumes a joint 
orientation of +x.

Set Preferred Angle limitation
Using Skeleton > Set Preferred Angle on joints in a chain controlled by an IK 
Handle will appear to have no effect.

Workaround

Create the IK handle after setting the preferred angles of the joints. 
Alternatively, deleting the IK handle and then performing an Undo operation 
to restore it will yield an IK solution that respects preferred angle.

Skinning limitations
The following limitations and workarounds relate to smooth and rigid skinning 
issues in Maya

Colorized skin weight display for vertices does not work for 
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NURBS or Subdivision Surfaces
The colorized skin weight display on vertices (set by the Colorize Skeleton 
option in the Smooth Bind Options window) is only supported for polygonal 
objects. However, skin weight coloring for surfaces is supported on all 
geometry types.
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General deformer limitations
The following limitations and workarounds relate to deformers (non-skin 
deformations) in Autodesk® Maya®.

Adding a new influence object to a smooth skin
If you add a new influence object to a smooth skin, it will not immediately 
appear in the Component Editor.

Workaround 

Close the Component Editor and reopen it.

Unpredictable results when changing an object’s topology 
upstream from a deformation

Changing an object’s topology upstream from a deformation causes 
unpredictable results. When you deform an object, Maya generates 
references to some of the object’s components (CVs of NURBS curves or 
surfaces, polygon vertices, or deformed lattice points). 

There are several ways to change the topology (for instance, the number of 
such components the object has) “upstream” of the deformations. For 
example:

The Rebuild Curve operation may change the number of CVs in a curve, 
changing the sections or spans attributes of a makeNurbSphere node may 
change the number of CVs in the resulting NURBS surface, and the Polygons 
> Smooth operation can drastically change the number of polygon vertices in 
the smoothed object. Unfortunately, Maya does not yet have a way to 
communicate these changes to the nodes downstream in a way that allows 
the “right thing” to happen.

Workaround

If the object being modified is being deformed: remove the object from the 
deformer’s deformation set, apply the topology-changing operation, and then 
restore the modified object to the deformation set. If the deformation was a 
cluster and you had edited the associated percentages, you must repeat that 
step after changing the object’s topology.

If the object being modified is bound as skin to a skeleton: Detach it from 
the skeleton (Skinning > Detach Skin), apply the topology-changing operation, 
and then rebind the skin (Skinning > Bind Skin).

If the object being modified is a curve used as a wire curve (for instance, it is 
the “influence object” for a wire deformation): Remove the curve from the 
wire deformer, change its topology, and then add it back to the wire.

Other examples of this limitation
• Wrap behaving unpredictably
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If you modify the face or CV count of shapes used as wrap deformers, the 
wrap behaves unpredictably.

Workaround

Remove the shape as an influence object and then add it as an influence 
object again. This will reset the data for the wrap so that it will work again.

• Changing the CV count of a deformed object downstream

If you change the CV count of a deformed object downstream (after) the 
deformation, translate, rotate and scale of the CVs of the object may affect 
the wrong CV. Examples of operations that would cause this problem are: 
inserting or removing a knot on a NURBS surface, or deleting a polygon face 
or vertex.

Workaround

Disconnect the message attribute connection between the deformed shape 
and the tweak node. To do this, select the shape and display its history in 
the Hypergraph. You will see a connection between a tweak node and the 
shape. Select the connection and press the Delete key to break the 
connection.

Lattices with partial resolution may distort target geometry
The loss of accuracy caused by the Partial Resolution Lattice deformer 
setting may severely distort lattice deformed geometry.

Workaround

Decrease the value of the Lattice deformer’s Partial Resolution attribute, or 
use Full Resolution.

Jiggle deformers may not evaluate properly when used in 
combination with Fur or motion blur

Workaround

Batch rendering of Fur objects and motion blur with the jiggle deformer 
requires the creation of a jiggle disk cache.

Ghosting is not reliable on jiggle deformations
Workaround

Creating a jiggle disk cache will typically allow ghosting to work on the jiggle 
object.
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NURBS modeling limitations

Bevel Plus limitation
In some rare occasions when Bevel at Start is turned off, undesirable results 
may occur if the end face becomes self-intersecting. 

Workaround

Turn on Bevel at Start, turn off Bevel at End and set the Bevel Depth and 
Extrusion Length to negative values (precede the value with a “-”). If required, 
modify the original curve to ensure desired results.

Create Adobe Illustrator Object limitations

Unexpected results when importing an Illustrator file
In certain cases, you may find that an imported Adobe Illustrator file shows 
points shooting off or other strange geometry.

Workaround

You may be able to fix the problem by changing the position of the origin or 
type in the Illustrator file and re-importing. 

Adobe Illustrator file does not import
You may get an error similar to the following:

// Error: bevelPlus1 (Bevel Plus Node): Group 2 curve 4 is not 
inside the previous curve. Group these curves appropriately in 
Adobe (R) Illustrator (R) 

// Error: Failed to create bevel output //

Workaround

You may need to fix the groupings and compound paths in the Adobe 
Illustrator file. If Maya doesn’t import anything, you need to perform the 
Create Adobe Illustrator Object operation again. 

Beveled text does not tessellate correctly when rendered
Sometimes the surface created using Create Adobe Illustrator Object and 
Bevel appears fine in wireframe mode, but displays poorly in shaded mode. 
These kinds of surfaces do not render well in the Maya renderer because of 
poor tessellation. 

Because mental ray uses a different tessellation algorithm, rendering with 
mental ray can produce significantly better results.
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Subdivision Surfaces limitations

Weight field for a subdivision surface vertex member of a 
deformer set may appear blank

The weight field for a subdivision surface vertex member of a deformer set 
(cluster, skinCluster, or jointCluster) may sometimes appear blank, and 
entering new weight values has no effect.

Workaround

Pick the cluster handle or joint and select the cluster members by using Edit 
Membership Tool. Use the Component Editor to now display and edit weight 
values for the cluster members. If you turn off List >Auto Update in the 
Component Editor window, clicking the name of the component in the first 
column of the table will identify the cluster member by selecting it in the 
scene view.

Unexpected results with non-proportionally scaled Subdivision 
surfaces

Subdivision surfaces with non-proportional scale and hierarchical edits may 
not behave properly when a rotation is applied to the coarse mesh 
components (including base).

Workaround

Use Modify > Freeze Transformations with the scale option set to remove the 
non-proportional scale from the object in question.

Selecting UV vertices on texture borders in the UV Texture 
Editor

In the UV Texture Editor, selecting UV vertices that are on texture borders 
may sometimes result in multiple vertices being picked. 
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General polygon and games limitations
The following lists general polygon and games limitations and workarounds.

Crease node with history can affect Smooth Mesh performance
The interactive performance of vertex edits to polygon meshes displayed in 
Smooth Mesh Preview mode may be adversely affected whenever a crease 
node is contained in the construction history. This is noticeable immediately 
after the first click-drag of the mouse.

Workaround

Avoid having a crease node in the polygon meshes construction history, or 
delete the construction history before performing the vertex edits. 

Magnet tolerance when using Insert and Offset Edge Loop tools 
The Insert and Offset Edge Loop tools only snap to the ends of a selected 
edge whenever the Snap magnets preference setting is greater than 0 and 
the Magnet tolerance setting is set to a high value (for example, 10). 

Workaround 

Reduce the Magnet tolerance setting to a lower value, or set the Snap 
magnets setting to 0.

Shared faces with opposite UV winding may have normals 
reversed

When working with UV maps on a mesh that has two faces with opposite 
winding orders, but that share UVs across one edge, the normals on one face 
may display incorrectly, as if the face was split down the middle and flipped. 

Workaround

For many scenes with this problem, unshare either the UVs or the normals 
along the shared edge to correct the problem.

Combining instanced polygon meshes may delete geometry
Combining two instanced polygon meshes using the Combine command can 
result in one of the two polygon meshes being deleted without prior warning. 
This occurs when the transform node for one of the selected polygon meshes 
has more than one DAG path from the root level.

Workaround

If this occurs, duplicate the polygon meshes using the Copy option prior to 
using the Combine command.

UV snapping in UV Texture Editor appears offset when Retain 
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Component Spacing is turned on
UV texture coordinates may not snap to the grid in a predictable manner in 
the UV Texture Editor when Retain Component Spacing is turned on for the 
Move Tool. That is, the UVs can be moved, and the component spacing is 
maintained, but the grid snapping appears offset.

Shell option in Constraint Selection feature selects UV texture 
shells instead of polygon shells

In previous versions of Maya, the Select Using Constraints feature (Select > 
Select Using Constraints) selected polygon shells when the propagation 
option was set to Shell. In Maya 8.5 this behavior changed so that only UV  
texture shells became selected.

Workaround

Select a component on the object where you want to select a polygon shell 
and then convert the selection by selecting Select > Convert Selection > To 
Shell.

UV layouts appear different on other platforms and versions
Recent changes to how floating point calculations are computed in Maya has 
resulted in changes to the order in which UV shells are calculated. As a 
result, the layout of UVs may appear different when the file is subsequently 
loaded in Maya on a different hardware platform or a later version, 
particularly when the original UV layout has been edited.

Workaround

Delete the history in the original file and then save it before attempting to 
open it on another platform or version.

Black color per vertex values are not saved on corner vertices
Black color per vertex values that are assigned to corner vertices of a polygon 
mesh are not retained when the file is saved. The CPV information on the 
corner vertices of the mesh values appears white or grey when the file is 
subsequently opened.

Workaround

If you need to apply black CPV values to corner vertices, use a small 
numerical value instead of 0. (For example, 0.01)

Maya does not maintain the order of selected components
The global selection list does not preserve selection order of polygon mesh 
vertices, faces, edges. 

Workaround

Use the following script to collect each selected component in an array, and 
then use the array as desired.
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global proc selectProc()  

{  

global string $gSelectedComponents[];  

string $selC[] = `ls -sl -flatten`;  

if (size($selC) > 0) {  

int $match = 0;  

for ($newSel in $selC) {  

$match = 0;  

for ($oneComponent in $gSelectedComponents) {  

if ($newSel == $oneComponent)  

$match = 1;  

}  

 

if ($match == 0)  

$gSelectedComponents[size($gSelectedComponents)] = $newSel;  

}  

} else {  

clear ($gSelectedComponents);  

}  

int $debug = 1;  

if ($debug && (size($selC) > 0)) {  

print ("Selected components (in the order) ...\n");  

print ($gSelectedComponents);  

print ("\n");  

}  

}  

 

// to load the scriptJob  

int $jobNum = `scriptJob -e "SelectionChanged" "selectProc"`;  

 

// to unload the scriptJob  

scriptJob -kill $jobNum; 

Blend weights limited to 0 to 1 range in Color Set Editor
Blending color sets using the Blend option in the Color Set Editor results in 
the blend weights being limited to the 0 to 1 range when the image is 
rendered. That is, blend weight values higher than 1 are clamped to a 
maximum value of 1. This is a known limitation of the OpenGL default 
rendering pipeline. 

Poly component convert selection
When you have multiple component types selected and choose a polygon 
action, Maya automatically converts the selection to that expected by the 
action. This automatic conversion has been implemented on all poly 
commands except the following: 

• polyEditUV

• polyGeoSampler

• displacementToPoly
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• untangleUV

• polyUVSet

• polyProjection

• polyNormalPerVertex

• polyForceUV

• polyFlipEdge

• polyColorPerVertex

• polyClipBoard

• polyBlindData

• polyAverageNormal

• blindDataType

• polyCreate

• polyUnite

• polySeparate

• polyBoolOp

• polyWedgeFace

In addition to those corresponding to the above commands, the following 
menu items will also not perform the conversion:

• Extrude

• Transform Component

• Subdiv Proxy

• Duplicate Face

• Extract

Polygonal faces disappear in shaded mode
When you apply a Freeze Transformations operation on an object, the 
“opposite” rendering option is automatically turned on. This means front-
faced polygons are culled when in back-face culling mode in 3D views. 

When back-face culling is also on in the polygon display options, back-faced 
polygons are also culled. If the object is not selected, all the polygonal faces 
are culled in shaded mode display making it seem as though the object has 
disappeared. 

cp attribute limitation
On polygonal objects, the cp attribute is supposed to represent the actual 
position in local space of a vertex, while the pnts attribute represents the 
tweak value (its offset relative to the rest position). 

The cp attribute is a compound attribute with child attributes named xv/yv/zv. 
When you get the value of the parent attribute, Maya incorrectly returns the 
same value as for the pnts attribute. 
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Workaround 

Use the xv/yv/zv child attributes individually instead of the entire cp 
compound attribute.

For example:

polyCube; select -r pCube1.vtx[0] ; move -r .1 .1 .1; 

getAttr pCube1.cp[0]; 

// Result: 0.1 0.1 0.1 //  
 getAttr pCube1.cp[0].xv; 

// Result: -0.4 // Real X position (-.5 + .1)

polySeparate command
The polySeparate command fails if the object is invisible.

The error message in this case can be misleading: 

Warning: polySeparate works only on polygonal objects.

Workaround

Make the object visible.

Booleans do not preserve color per vertex and component level 
blind data info

Mesh > Booleans operations do not preserve color per vertex or component 
level blind data information. 

Flipping edges from multiple objects
Flipping edges from multiple objects at the same time can lead to a crash. 

Workaround

Select and flip edges from one object at a time.

Color per vertex animation not working for polygonal objects 
without history

Color per vertex animation will not work for polygonal objects which do not 
have modeling/construction history. 

Workaround

Introduce some benign construction history (such as a move component 
operation that doesn't actually move anything).

Unexpected results in Cleanup when removing lamina faces 
and non-manifold geometry

When using Cleanup, combining the removal of lamina faces with the removal 
of non-manifold geometry can lead to unexpected results. 
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Workaround

Clean up the lamina faces first. In many cases, this also eliminates the non-
manifold geometry.

MfnMesh limitations
The MFnMesh::assign UVs() method does not properly support history. As a 
result, UVs can be removed as history rebuilds the object.

The MFnMesh::create UVSet() method does not work if the MFnMesh is using 
mesh data.

Envelope attribute for Transfer Attributes
The Envelope attribute is not supported for TransferAttributes. 

User defined normals ignored on skinned polygon mesh
User defined (locked) normals are ignored on a non-uniformly scaled polygon 
mesh when it is subsequently skinned. 

Workaround

Freeze transformations on the polygon mesh prior to skinning.
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Artisan limitations
The following lists Artisan limitations and workarounds.

Paint Vertex Color Tool
Map Import/Export cannot be used when painting vertex faces as opposed to 
vertices. 

Color feedback in Artisan tools
• Although they work the way they should, trimmed surfaces do not display 

color feedback in Artisan tools. 

Exporting attribute maps from NURBS surfaces
Exporting attribute maps will not work correctly for NURBS surfaces with a 
degree other than 3.

Importing subdiv edge selection map
Importing subdiv edge selection map will not work. 

Workaround

Import them as Vertices and convert the selection to edges. 

3D Paint Tool limitations
The following lists 3D Paint Tool limitations and workarounds. 

Unable to paint on textures assigned to layered shaders
You cannot paint on textures assigned to layered shaders. 

3D Paint slow with large textures
If you find a large slowdown in performance when editing larger than 1K by 
1K images then this could be due to insufficient video card memory to 
display textures at that resolution. 

Workaround

You have the option to clamp the maximum size of textures used for display 
by setting the Maximum Texture Display Resolution, which is in the Display 
category of the Preferences window (Window > Settings/Preferences > 
Preferences). It is recommended that you restart Autodesk® Maya® in order 
for these settings to take effect.
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Texture placement
The 3D Paint Tool ignores any changes you make to texture placement 
parameters. 

Workaround

Convert the texture with modified texture placement to a file texture (Edit > 
Convert to File Texture, in Hypershade) and paint on the converted texture.

Painting with Fast Interaction
The 3D Paint Tool doesn’t work when Display > Fast Interaction is turned on. 

Workaround

Turn Fast Interaction off while painting. 

Paint Effects limitations
The following lists Paint Effects limitations and workarounds.

Self-shadowing and directional lights
When rendering Paint Effects with a directional light, self-shadowing may not 
compute correctly. 

Workaround

Replace the directional light with a narrow spot light that is located far 
enough away from the objects in the scene that the light is effectively 
directional.

Paint Effects strokes that had transformations applied to the 
strokes themselves may sometimes appear different from 6.5 
to 7.0. 

Prior to 7.0, if a stroke painted on the view plane was rotated, and 
useNormal was ON, the stroke may not be drawn correctly if it was 
dependant on the stroke normal. If you have older files where you have 
adjusted some paint effects brush attributes to compensate for the draw 
problems with transformed strokes, these strokes may appear different in 
7.0. Strokes painted on a surface should not have this problem. 

Workaround

Re-adjust those same attributes that were used to compensate originally, if 
that information is still available. If it is not, you can convert the strokes to 
polygons in 6.5 and delete history for an accurate match. You may also find 
that modifying the normal on the stroke node may help you to match the pre-
7.0 look of the stroke. 
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Missing comma in output of pfxstrokes command
The file output of the pfxstrokes command was modified in Maya 7.0 to add 
a missing comma. The comma location is following the normalZ value for 
pfxHair nodes. 

Workaround

Any user scripts created in Maya 6.5, or an earlier version of Maya, that 
previously worked around this missing comma will need to be updated.

Pop-up menu on color boxes in Paint Effects Brush Settings 
window

The Paint Effects Brush Settings window has various color slider attributes on 
which you can right-click and a pop-up menu appears. Of the items displayed 
in this menu, only the Color Chooser item has any effect. The rest of these 
items should be ignored as they will not change the behavior of the color 
value. 

Paint Effects Mesh brushes
The interpolation for Paint Effects triangles with Mesh brushes may result in 
distorted textures where the triangle count is low. 

Workaround

Increase the triangle density on the brush or convert the Paint Effects strokes 
to polygons to render.

Film fit adversely affects Paint Effects
Workaround

Set the film aspect ratio to match the xres/yres, or the value shown in the 
Device Aspect Ratio in the Render Settings window. Be careful not to push 
the film aspect too far (too low in the example file) or the perspective will 
change. 

Renaming strokes with brush springs
If a Paint Effects stroke has brush springs and the brush is renamed, the 
springs may no longer evaluate correctly. 

Workaround

Rename the brush back or edit the expressions to reference the new brush 
name.

Interactive Performance Settings and redrawing strokes
If the Performance Settings for Paint Effects are set to Interactive, then 
immediately following playback, updates to the selected stroke/brush will not 
cause the stroke to be redrawn. 
Autodesk Maya 2008 Release Notes
47



10 | Artisan, 3D Paint, and Paint Effects
Release notes > Paint Effects limitations
Workaround

Select some other object, then re-select the stroke. Interactive updates will 
now work.

Strokes rendering white with light fog
Light fog causes Paint Effects strokes to render white. 

Workaround

If the lights in your scene have light fog, turn off "Real Lights" for any 
brushes that have "Illuminated" turned on.

Turbulence stops working during playback
Once it is turned off, turbulence stops working on Paint Effects stroke during 
playback. 

Workaround

Open the Flow Animation block in the Attribute Editor.

Paint Effects canvas wrapping with Mesh and ThinLine brushes
Paint Effects brushes with a ThinLine or Mesh brushType do not wrap when 
scene or canvas wrap is on. 

Stroke shadows in IPR
Paint Effects strokes do not show up in IPR, but their cast shadows do. 

Workaround

Hide the strokes before rendering to prevent the shadows from being shown.

Light linking
Paint Effects does not support light linking. 

Field rendering
Paint Effects does not support Field Rendering. 

Workaround

Render with the By Frame value set to 0.5 and interlace in a compositing 
package.

Popping near the edge of a frame
Paint Effects renders can sometimes ‘pop’ where the stroke is near the edge 
of the frame. 

Workaround

Increasing the stamp density and transparency may fix this.
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Scaled objects and jumping strokes
On objects that are scaled very large, Paint Effects strokes may ‘jump’ when 
crossing isoparametric lines on the surface. 

Workaround

To prevent this, apply the Freeze Transformations command to the object.

Z-up environment
Paint Effects gives unexpected results in a Z-up environment. 

Workaround

Set the environment to Y-up and restart Maya.

Freeze Transformations
Freeze Transformations does not work for Paint Effects strokes. 

Transformations and units
Paint Effects can give unexpected transformation results if the units are not 
set to centimeters. 

Playing back scripts
Parameters that are dynamically set on stroke creation, such as pressure 
values and settings, are not arguments to the stroke command itself. Playing 
back scripts will therefore not exactly match what you created. 

Changing Screenspace Width option
If you turn on Screenspace Width for an object like a tree, the tree size is 
now based on the canvas scale, not the scene scale. 

Workaround

Make the canvas scale equal to the scene scale, and then scale down the 
widths of the tubes, flowers and leaves to the desired levels.

Modifying 3D Paint Tool textures in the Paint Effects canvas
A file texture may not update correctly when you try to use the Paint Effects 
canvas to edit a texture map created with the 3D Paint Tool. 

Workaround

Save the scene before trying to edit the texture in the Paint Effects canvas. 

Most recent brushstroke gets re-drawn several pixels off
Using paint effects, some graphics cards may redraw the last stroke drawn a 
few pixels off from where it was. 
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Workaround

Before running Maya, set the environment variable 
MAYA_RENDERVIEW_USE_TEXTURES to 1. Maya will then use an OpenGL 
texture call to draw the stroke instead of the normal glDrawPixel call.

Eyedropper doesn't work in Paint Vertex Color tool
The eyedropper doesn’t work in the Paint Vertex Color Tool.

Workaround

Use the eydropper icon in the color chooser window. 

Particle clouds and Paint Effect Strokes don’t mix
After creating a Particle cloud emitter with Paint Effects strokes, the strokes 
become clipped by cloud shapes in front of them. 

Workaround

Composite the particle cloud seperately.

3D Paint issues with mental ray for Maya
When painting a texture with 3D Paint, mental ray for Maya will not pick up 
new paint strokes automatically.

Workaround

Save either the texture being painted or the entire scene before rendering 
with mental ray to ensure that all strokes are rendered correctly.
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Dynamics limitations

Particle system can have inconsistent results between disk 
cache and non disk cache when using rand() in expression

Workaround

Seed the random number. For example, if(frame < 2) seed(1). 

Rigid bodies have a different playback result after saving the 
scene

The cycle involved with the rigid solver causes a different evaluation order. 
This problem has to do with to the DG evaluation order in a cycle.

Workaround

Before you save the scene that contains rigid bodies, do the following:

1 Select Solvers > Memory Caching > Delete.

2 Select Solvers > Memory Caching > Disable.

Interactive Playback limitations 
Interactive Playback does not currently work with passive rigid bodies. For 
example, if a passive rigid body is moved while the solver is playing, active 
rigid bodies will only collide with the passive rigid body in its original position. 

Surface emission from a trimmed surface won’t reflect new 
holes

With surface emission from a trimmed surface, if you add more trims or 
untrim the surface, the emission won't reflect the new holes.

Workaround

Bring up the geoConnector node associated with the emitter, and change the 
tessellation value a little, for instance, from 200 to 201. This forces re-
tessellation, and the re-tessellation picks up the new trims correctly.

Rigid body keyframed passive to active resets incorrectly
Rigid body keyframed passive to active resets incorrectly if you don't freeze 
transform. 

Workaround

Model your object first, select Modify > Freeze Transformations, then set 
active/passive keys, adding any fields as the last step.
Autodesk Maya 2008 Release Notes
51



11 | Dynamics
Release notes > Dynamics limitations
Flow effects and curve flow don't work if units not in cm
Workaround

Set the scene units to cm, create a new scene, then reopen original scene.

File referencing not supported for particle expressions
Workaround

Put your particle expressions in the main file. 

Fields and emitters don't convert particle positions
Fields and emitters don't convert particle positions for non-standard units

Workaround

Use standard units. 

Particles may collide on creation 
Particles may collide on creation when surface emitter is also a collision 
object. 

Workaround

Reverse the normal speed parameter of the surface emission.

Rotate pivot and instancing
Instancing does not handle situations where the rotate pivot is not at the 
origin.

Workaround

See the script, createInstancerPivot.mel in the scripts/unsupported directory 
(under the main Maya install directory). The script contains directions for use.

Hardware rendering with motion blur limitation
Hardware rendering with motion blur works only if the multipass value is set 
at least as high as the motion blur value. 

Identical rigid bodies may not collide
Two identical rigid bodies on top of one another may not collide.

Workaround

Scale, rotate, or translate one of the rigid bodies slightly.

Rigid bodies do not recognize non-planar polygons 
Workaround

Triangulate the non-planar polygons.
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Copying a rigid body/rigid constraint systems
When copying a rigid body/rigid constraint system, the copied constraint does 
not connect to the copied rigid body.

Workaround

Turn on Duplicate Input Graph in the Edit > Duplicate options window.

Ghosting is not reliable on simulated objects such as particle 
simulations, soft bodies, and rigid bodies

Ghosting is not reliable on simulated objects such as particle simulations, 
soft bodies, rigid bodies, classic cloth and jiggle deformers. 

Workaround

Creating a disk cache for the simulation will typically allow ghosting to work 
on the object.

Particles may not evaluate properly when using emit command 
to emit particles

This problematic behavior may be the result of the expression not being 
executed or Maya may be getting the incorrect amount of particles during 
batch mode or prompt mode.

Workaround

Invoke getAttr on the count attribute in the order where the events are 
expected to happen. The getAttr can be called from within a MEL script or a 
regular expression as long as it happens once every frame.

Error messages appear if you modify soft body polygon 
topology

Modifying a polygon object's topology (by editing its upstream construction 
history) after making it a soft body will result in error messages.  

Workaround

Adjust the construction history as desired before creating the soft body, or 
delete and recreate the soft body after such changes. 

Exporting to .mi with dynamics
Exporting to .mi interactively may produce incorrect results with dynamics. 

Workaround

Do one of the following:

• Manually run up the scene to the current frame and export

• Use batch export to .mi 
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General rendering limitations
The following lists miscellaneous rendering limitations and workarounds.

Changing polygonal topology may affect shader assignments
Changing the topology (number of faces) on a polygonal object by modifying 
attribute values on history nodes connected to the object can adversely affect 
shader assignments. This happens if the shader assignment is done after 
the operation that modifies the topology, or at the component (face) level (for 
instance, shaders assigned to portions of the object instead of the entire 
object). 

Workaround

Redo the shader assignment after the topological modifications have been 
completed.

Rendering scripts
The following command line rendering scripts are now unsupported:

• mayarender_with_mr

• mayaexport_with_mr

• mayaVectorRender

mayabatch -render command obsolete
The mayabatch -render flag on Windows (maya -render on Linux/Mac OS 
X) is obsolete and has been removed. Use the Render -r command instead. 

Output to AVI only renders frame one
If you select AVI as the image format for your render output, and you have 
never clicked the Compression button in the Render Settings window, your 
render output may only include frame one. 

Workaround

In the Render Settings window: Common tab, select AVI as your image format 
and press the Compression button. Select a compression scheme from the 
Compressor drop-down list and click OK.

Batch rendering an AVI sequence may create a NULL AVI file
When batch rendering an AVI sequence and the generated AVI file is NULL, 
switch to a different compressor, or, select the uncompressed setting 
instead. 

Batch rendering from within Maya on Mac OS X writes to console and 
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mayaRender.log
On the Mac OS X platform, when you batch render from within Maya, the 
output is sent to the Console Application as well as logged in ~/Library/
Logs/Maya with the name mayaRender.log. 

Interactive scene view limitations

Seams noticeable during texture baking
Within Maya's scene view, texture seams may appear on objects after mental 
ray baking, even when Fill Texture Seams is used during baking. 

Workaround

Either scale down the UVs on the objects in your scene and/or render.

(Mac OS X) Alpha channel display
Alpha channel display in image planes do not display properly.

View fit problems with joints
View fit has problems with some joints, where it will zoom out too far. 

Resolution Gate and Film Gate incorrectly display
Resolution Gate and Film Gate may not correctly display with non-standard 
Film Fit Offsets, when Film Fit is set to Vertical or Fill. 

Workaround

The Horizontal setting works correctly.

Camera limitations

Look Through Selected
Look Through Selected can produce unexpected results if the camera is 
duplicated, or the scene is saved. 

Manipulator undo and two- or three-node cameras
Manipulator undo does not work for two- or three-node cameras. 

Problems if camera not proportionally scaled
Problems exist if the camera is not proportionally scaled. The view and render 
will be skewed and manipulation may result in odd behavior. 

Hypershade limitations

Deleting shaders
When deleting shaders in Hypershade, its shading group is not deleted. This 
may result in orphaned shading groups, or worse, whatever was assigned to 
that shading group now does not show up in software rendering, and only 
shows up as dense wireframe in hardware shading. 
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Workaround 

To get around the latter problem of software and hardware rendering, 
reassign those objects to another shader. 

Showing tabs
When flipping back and forth between showing top/bottom/both tabs, the 
view is not reset, and may mislead the user into thinking that whatever was 
visible in one of the tabs is now invisible. 

Workaround 

To resolve this, set View > Frame All for the problem tab. 

Render Layers/Passes limitations

Assigning objects to Render Layers through the Relationship editor
Assigning objects to Render Layers via the Relationship editor is not 
recommended since you may inadvertently assign an object without it's 
transform. 

Workaround

Use the Render Layer editor to assign objects to layers.

Shadow passes and objects assigned with layered shaders
The shadow pass results may be incorrect from objects assigned with layered 
shaders. 

Workaround

Pick one of the shaders that is connected to the layeredShader, and connect 
up that shader's outMatteOpacityR to the layeredShader's matteOpacity 
attribute.

(Linux) Render layer color indicators do not appear correctly
If you have a modified MayaScheme file, you may not see the correct layer 
indicator colors for selected layers in the Layer editors (light blue and darker 
blue). As well, you may not see the correct color indicator for the override of 
layer attributes (orange and bolded). 

Workaround

Add the following lines to your custom MayaScheme file:

*layerAdjustmentTextForeground: #e56929  
*blueSelectBackgroundColor1: #3884c4 
*blueSelectBackgroundColor2: #81a7c1
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Raytracing limitations

Translucence limitation with raytraced shadows
When using raytraced shadows on a translucent object, the Translucence 
Depth parameter will not function correctly unless the object's transparency 
is non-zero. If the transparency is zero, no light will ever penetrate through 
the object, regardless of the Translucence Depth value. 

Workaround

Adding a tiny amount of transparency to the translucent object will cause all 
translucence parameters to behave as expected.

Rendering workflow issues

Light-linking with plug-in lights
There are some problems involving light-linking with plug-in lights:

• They do not appear in the Light-linking Editor or Relationship Editor.

• The query option to the lightLink command does not work for plug-in 
lights. This results in Lighting/Shading > Select Objects Illuminated by 
Light and Lighting/Shading > Select Lights Illuminating Objects failing.

Light Linking Editor and deleting lights
The Light Linking Editor sometimes gets confused when you delete lights 
while using it. You may see error messages such as: “Error: No object 
matches name: directionalLight1” after deleting a light. Also, the display of 
which lights are selected can be incorrect after undoing a light’s deletion.

Workaround

Deselect everything in a modeling view to clear the editor.

Break Connection on Environment Fog does not delete fog
If you have turned on Environment Fog in the Render Settings window, and try 
to turn it off later using right-mouse button Break Connection, the fog 
remains. 

Workaround

Find the Environment Fog material in Hypershade and delete it.

Maya Software rendering limitations
The following lists miscellaneous software rendering limitations and workarounds.

Software rendering from the command line
The software rendering command line (mayaSWrender.exe) is now 
unsupported.
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Texture reference objects limitation
Texture reference objects do not work with several things, including 
displacement mapping and subdivision surfaces.

Shadow color has no effect on surfaces
Shadow color has no effect on surfaces assigned to a useBackground 
shader.

Bump mapping Stencil textures
You must make manual, explicit connections to bump map Stencil textures. 

Workaround

Bump map the texture, then manually connect the bumpValue to the stencil 
outAlpha.

Raytracing refractions through a useBackground shader
When raytracing refractions through a useBackground shader, artifacts may 
appear on the useBackground shaded surface. 

Workaround

In such cases, set the “refractions” attribute of the refracted object’s shader 
to off. 

Per-patch shading assignment
Per-patch shading assignment is currently not respected when software 
rendering. 

Optimized scene file location when using the -optimizeRender flag
When using the -optimizeRender flag, the location for the optimized scene file 
to be created is based on the current project defined by the preferences or by 
the MAYA_PROJECT environment variable. 

Workaround

Provide the absolute path where you would like the optimized file to be 
created.

General motion blur and Maya Software rendering limitations
• Motion blur does not work with software particles. 

• When you have a light illuminating a moving object, the object’s shadow 
does not blur correctly (use mental ray rendering instead).

• When you have a moving spot light that illuminates a surface, the spot 
light’s beam moving across the surface does not blur (use mental ray 
rendering instead).

• Motion blur is not rendered in raytraced reflections and refractions.
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Maya Software IPR Rendering limitations

General IPR limitations
• IPR does not support raytracing, 3d motion blur, or particles. Use mental 

ray IPR instead. 

• IPR does not properly handle shadows on objects with a Use Background 
material.

IPR and mental ray for Maya rendering and animated parameters
mental ray for Maya does not update animated parameters, including 
changes to the time slider, when using IPR (Interactive Photorealistic 
Rendering).

IPR image plane display options
IPR doesn’t respect image plane display options. When updating, IPR 
displays the image plane in the background though the image plane is set to 
none.

Workaround

Delete the image plane.

Manual feedback from IPR
Manual updates are needed to get feedback from IPR when making changes 
to:

• image planes 

• shadow maps due to light location changing, depth map resolution 
changing, or the auto focus changing 

• tessellation 

Workaround

Redo the IPR render after these changes (or select IPR > Update Shadow 
Maps).

Using Apply Fog in Post
When using Apply Fog in Post, the results cannot be seen in IPR. 

mental ray for Maya rendering limitations
This section contains information about the unsupported features, software 
limitations and workarounds, as well as some tips for this version of mental ray 
for Maya.

Unsupported features
mental ray for Maya does not support the following Maya rendering features:
Autodesk Maya 2008 Release Notes

60



12 | Rendering
Release notes > mental ray for Maya rendering limitations
• Keyframing or set driven keyframing on the RGB components of a ramp 
shader’s colorEntryList (the list of colors that comprise the ramp shader) are 
unsupported.

• postprocessing effects: Paint Effects, light glow, optical effects, and 2d 
motion blur

• Field Rendering

• The -hardware_echo flag is not supported through the command line. 

Known limitations
The following lists the software limitations and workarounds for this version of 
mental ray for Maya.

mental ray impacted by Hyperthreading
Intel CPUs offer hyperthreading as a feature to simulate additional logical 
processors which are actually running on a single physical CPU. This feature 
is intended to accelerate applications which make use of additional 
processors for parallel execution like mental ray. However, since 
hyperthreads are not able to deliver a performance gain like a physical 
processor but only about 15-25%, the performance increase may be small or 
not visible. 

Workaround 1

Turn off hyperthreading when using mental ray. 

Workaround 2

Disable “Auto Render Threads” and set the number of render threads 
manually.

Shadow method is set to Simple by default; simple shadows are not 
compatible with volume effects

The Shadow Method in the Render Settings window: mental ray tab is set to 
Simple by default. Simple shadows are not compatible with volume effects 
such as fluids, volume fur, particles and volume shaders and therefore may 
not render shadow volume effects correctly. 

Solution

Use Shadow Method Segments.

Intersecting fluids show artifacts in mental ray rendering 
Intersecting volume effects such as fluids, particle clouds and volumetric 
lights may cause artifacts in mental ray rendering. For example, the bounding 
box may show in the rendered image. 

Workaround 1

Avoid an overlap of the volume containers.
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Workaround 2

Render each volume effect via a separate layer and composite the layers into 
a final image.

Material swatches do not update during mental ray IPR
When rendering in mental ray IPR, material swatches in the Hypershade and 
Attribute Editor do not update with adjustments.

To get swatches re-rendered with mental ray, stop mental ray IPR.

mental ray contour shaders are not compatible large images
mental ray contour shaders cannot handle large images with high resolution 
(for example, >6K).

Workaround

Use Maya shaders instead.

Contour rendering artifacts (on Mac OS X)
In some cases, artifacts appear when rendering contours in mental ray for 
Maya. 

Workaround

Export the scene to .mi and render in mental ray standalone.

Exporting to .mi with dynamics
Exporting to .mi interactively may produce incorrect results with dynamics. 

Workaround

Do one of the following:

• Manually run up the scene to the current frame and export

• Use batch export to .mi 

Depth map shadow quality with Rapid scanline rendering
The quality of depth map shadows with Rapid scanline rendering is 
decreased compared to the quality of depth map shadows and default 
scanline rendering.

Workaround

In the Attribute Editor (light shape node), in the mental ray > Shadow Map 
Overrides section, increase the number of Samples.

Advanced filtering and file textures
Scenes that contain custom shaders for volume effects or environment 
shader may not render correctly with advanced filtering (quadratic, quartic, 
etc.) for file textures.

Workaround

Use mipmap filtering, or turn off filtering.
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Custom mental ray shaders and importing or referencing 
Imported or referenced Maya 5.0 files containing mental ray shaders, with 
color, scalar, or texture parameters, do not correctly convert in the current 
release of Maya. You may notice shaders becoming disconnected.

Workaround

Open the Maya 5.0 scene file in Maya Interactive, and save it. Then import or 
reference the file in the current release of Maya.

Maya's environment shaders do not work well with IBL
IBL provides UV coordinates to the attached shading network, but Maya’s 
environment shaders do not base their calculations on UVs. Maya 
environments are supported with final gather-based IBL, but photon and light 
emission are unsupported.

Fast subsurface scattering now more accurate but slower with final 
gather

Beginning Maya 2008, fast subsurface scattering is now more accurate when 
used with final gather but it is also slower. This is because the 
misss_lightmap_write() shader and all phenomena that use this shader now 
perform additional calculations to assure quality. 

Partial creases rendering as full creases
Partial creases of subdivision surfaces are not supported in this version of 
mental ray for Maya. They will be rendered as full creases. 

Depth map shadows 
Depth map shadows are not supported. 

Workaround

Use raytrace shadows.

Particle rendering
You can render the following particle types with mental ray: Points, 
MultiPoint, Spheres, Sprites, Streak, MultiStreak. The implementation builds 
on a geometry shader that creates actual geometry from per-particle data 
which is then passed on to mental ray for rendering. 

Hardware particles are shaded in a way that is similar to software particles: a 
shading group must be assigned to the particle shape, and its surface 
shader completely determines the appearance of the particles. This implies 
that none of the shading-related attributes are supported when rendering 
hardware particles with mental ray. 

spriteNumPP is unsupported; therefore, assigning different sprites on a per-
particle basis is impossible. mental ray and Maya Hardware may render 
particles slightly differently.  
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Directional light does not work well with Photons

Workaround 

Use a point or spot light instead. 

Warning messages appear when importing scene files in Hypershade
When importing scene files containing mental ray nodes, you may see 
warning messages such as: 

// Warning: 'Draft.message' is already connected to 
'mentalrayItemsList.options'. // 

These warning messages, about pre-existing connections between mental ray 
related node, are harmless and can be safely ignored. 

A warning dialog box also appears when these warnings occur. If you are 
importing many files and wish to avoid manually closing the warning dialog 
box for every file, you may want to use the file command with -prompt 
false.

Tearing off mental ray for Maya Render menu may crash Maya
If you tear off the Maya Render menu, then load the mental ray for Maya plug-
in and tear off the mental ray for Maya Render menu, Maya may crash. 

Workaround

Close the menu before loading mental ray for Maya.

mental ray for Maya crashes or won’t load when a firewall is active
Firewall software may block command ports. When you load mental ray for 
Maya, your firewall prompts you if you want "to allow the Maya application to 
access the internet: IP 127.0.0.1 port 1333." If you select no, Maya instantly 
exits without a warning or error message. If you select yes, mental ray for 
Maya starts up as expected. 

Workaround

If you are using any firewall software, you will need to give permission to 
Maya to communicate on port 1333 in order for mental ray for Maya to work 
correctly. 

Missing Motion Blur 
When rendering with motion blur, sometimes parts of deforming geometry will 
fail to blur. This is because sometimes, during animation, Maya creates 
incompatible changes to vital mesh data (number and order of vertices, 
normals, uv indices, polygons). You need to ensure a consistent tessellation 
for mental ray. 

Workaround

Turn on the "keep tesselation" flag on the smooth node, and do not 
triangulate.
Autodesk Maya 2008 Release Notes

64



12 | Rendering
Release notes > mental ray for Maya rendering limitations
Custom Text Does Not Work for Interactive Renders
The Custom Text feature is intended for use only with the mental ray 
standalone renderer. To correctly render a scene containing shader/object 
modifications made using Custom Text, the scene must first be exported to 
.mi format, then rendered with the standalone product.

Unsupported File Texture Formats
The following file texture formats are currently unsupported by mental ray for 
Maya: 

• AVI files

• Maya BOT files

• certain variants of the TIFF format (those with LZW compression, 
including those generated by the Maya renderer) 

• Cineon CIN files

• EPS files

• GIF files

• IFF16 files

• Wavefront-alpha files

Workaround

(TIFF,CIN,GIF) For these unsupported file formats, Maya's imgcvt image 
conversion tool can be used to convert the files to a supported format such 
as IFF or RGB. For a complete list of file texture types supported by mental 
ray, see the Rendering with mental ray Handbook.

(BOT) There is currently no workaround that will allow Maya BOT files to be 
used in conjunction with mental ray for Maya. mental ray does support its 
own memory-mapped map file texture format, however. Standard image files 
can be converted to this format using the imf_copy command:

imf_copy -p <filename>.rgb <filename>.map

See the Rendering with mental ray Handbook for a full description of memory-
mapped textures in mental ray.

3D Paint issues with mental ray for Maya
When painting a texture with 3D Paint, mental ray for Maya will not pick up 
new paint strokes automatically.

Workaround

Save either the texture being painted or the entire scene before rendering 
with mental ray to ensure that all strokes are rendered correctly.

mental ray images folder
By default, mental ray batch rendered images used to go to mentalRay/
images folder of the project. As a result of the design changes in Maya 7 
that made all renderers more consistent, any such images are now being 
saved to the images folder under the project. 
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mental ray for Maya transfer maps limitation
If, in addition to baking a mental ray transfer map, you also: 

• bake a Maya transfer map with the .tif file format, and 

• you choose the Connect maps to shader option,

then, when you bake a mental ray transfer map for a second time, mental ray 
generates an error.

mental ray does not understand the the LZW compressed TIF format.

Workaround:

You may do one of the following to avoid this error:

• Use a mental ray friendly file format for your Maya transfer map, for 
example, EXR or DDS.

• Assign a different material to the source surface before baking your 
mental ray transfer map for the second time.

• Unselect the Connect maps to shader option.

mental ray for Maya transfer Maps custom shaders limitation
When creating a Custom Map, Transfer Maps does not support baking 
Contour shaders or Geometry shaders to texture. Only Material shaders 
(shaders listed under the Materials section of the mental ray tab in the 
Create Render Node window) can be baked to texture. Ensure that your 
custom shader is recognized as a material shader in Maya. 

Removal of Zpic support
The Softimage Depth (Zpic) file format is no longer supported for mental ray 
for Maya rendering. 

mental ray mia_roundcorners shader to be used with double-sided 
geometry

The mental ray mia_roundcorners shader must be used with double-sided 
geometry. 

Surface changes during animation is not supported for mental ray for 
Maya motion blur

Surface changes (for example, changes to the number of vertices) during 
animation is not supported for mental ray for Maya motion blur. If the motion 
interval is large, so that the topology change occurs within this interval, 
mental ray issues the warning message “Shapes are not equivalent, no 
motion vectors computed” and skips motion data computation on the shape. 

Baking to one map in mental ray uses wrong UV set
When Bake to one map is enabled, mental ray currently only bakes the 
default UV set, regardless of the specified current UV set on the object.

Workaround

Use override mesh UV set assignments, and rename all UV sets to that 
name. 
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mental ray does not support multiple motion transforms
Multiple motion transforms is not supported by mental ray for Maya. To 
obtain curved motion blur, animation should be applied to the shape node 
and not to the transform. In addition, you must enable the Export Motion 
Segments option in the Render Settings: mental ray tab, under the 
Translation section. 

Image plane renders darker when mia_physicalsun shader is used
When you add the mia_physicalsun and mia_physicalsky to your scene using 
the Create button in the Environment section of the Render Settings, a 
network of nodes is automatically created, which includes the 
mia_exposure_simple shader that adjusts exposure. The 
mia_exposure_simple shader is added to the network because the 
mia_physicalsun and mia_physicalsky shaders create physically correct high 
dynamic range images that, when viewed without exposure control, will 
appear all white in the render view. The mia_exposure_simple shader not only 
affects the sun and sky but rather the entire scene including image planes. A 
standard image plane will appear darker relative to the bright sky. You can 
adjust the image plane's brightness using its Color Gain and Color Offset 
attributes, or using the attributes of the mia_exposure_simple shader.  

Command line render to .iff or .psd results in two separate files being 
rendered

A command line render to .iff or .psd, with Depth channel (Z depth) selected 
under Renderable Cameras, will produce two separate files, one for z-depth 
and one for RGB.  

Incorrect bounding boxes reported for fur node
Maya reports incorrect (zero) bounding boxes for its FurFeedback nodes.

Workaround

Enable Show > Locators and the bounding boxes will be correct. 

Rendering fur in mental ray with directional light produces artifacts 
Scenes with fur rendered by mental ray may appear with grid-like artifacts 
(vertical and horizontal lines), when the Fur Shader is set to Hair Primitive 
(Fur > Fur Render Settings > mental ray for Maya Fur render settings), and 
the scene is lit by Directional light(s). 

Workaround

1 Shut down Maya and mental ray standalone (if you are using it).

2 Set the following environment variable as indicated:

MI_HAIR_SPLITTING=0

For information on how to set environment variables, see the Environment 
Variables guide.

3 Start Maya and re-open your scene.

4 Re-render your scene. You can render from within Maya, or use mental ray 
standalone.
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mental ray satellite rendering limitations
The following lists miscellaneous mental ray satellite rendering limitations 
and workarounds. For more information on mental ray satellite, see “mental 
ray network rendering: Satellite and standalone” in the Rendering guide and 
“Overview of mental ray (satellite)” in the Installation and Licensing guide.

Uninstall mental ray satellite for previous versions before installing new 
mental ray satellite

The mental ray satellite for Maya packages have the same name. Therefore, 
you must manually uninstall previous versions of mental ray satellite before 
installing the current version of mental ray satellite. 

On Mac OS X, you need to use the mental ray satellite uninstaller in the 
mental ray satellite folder to properly uninstall this product. If you delete the 
mental ray satellite folder, port and machine associations may not be 
updated properly once you install the latest version of mental ray satellite. 

Compatibility issues
Due to a number of changes between mental ray satellite for previous 
versions of Maya and the current mental ray satellite, there are 
incompatibilities with using a master (with the current release of Maya) with 
slaves using a previous version of Maya.

Workaround

Use master and slave machines with the same version of Maya (for example, 
Maya 8.5 or Maya 8.0).

mental ray for Maya rendering tips

Rendering Color and Z-depth
The following is true when rendering to a format other than Maya IFF or RLA. 
If rendering to Maya IFF or RLA, all channels RGBAZ are written to one file. 
For all other image formats, when the Depth Channel (Z depth) option is 
enabled in the mental ray Render Settings, mental ray will write out a 
separate image file containing depth information. Z-depth is now written out 
in IFF format and rendered to a separate file that has “Depth” as a suffix to 
the image name, for example, imageDepth.#.iff. 

Notes • Using the MI_HAIR_SPLITTING environment variable requires 
significant memory. You may need to adjust your memory limit, 
especially on 64-bit systems (at least 3GB is recommended). 
You can explicitly set the memory limit in the mental ray Render 
Option window (Render > Render Current Frame > Memory).

• In addition, because this environment variable requires 
significant memory, you should only use it in specific cases, 
and otherwise disable it.
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Depth map shadow settings and volumes (like light fog)
To cast shadows into volumes you have to increase the number of Volume 
Samples in the Render Stats section of the shape node (coneShape1). This 
is standard procedure for ray trace shadows. mental ray requires you to do 
the same thing for Dmap shadows. To eliminate Dmap shadow artifacts on 
the cone boundary try increasing Samples in the mental ray Shadow Map 
Overrides section of the light shape node. 

Hardware rendering limitations
This section contains information about the unsupported features, limitations and 
workarounds for Hardware rendering.

Known limitations

Light linking for instanced lights
Hardware rendering supports per light-instance light linking. For example, two 
instances of a light shape can have different light linking.

For a light instance to illuminate the scene, the light instance should be 
connected to a light linker node, either indirectly through a light set, or 
directly through a transform node or a shape node.

If the light shape node is connected to a light linker node, all the instances 
of the light shape are affected.

The Light Linking Editor does not support instance light linking, so making 
per-instance light linking must be done indirectly by using light sets. 

For example, put light_instance1 and light_instance2 in separate light sets, 
and set light linking relationship of each of the light sets.

Breaking the light linking of a light_instance directly in the Light Linking Editor 
(as opposed to through lightset) operates on the light shape, resulting all the 
instances of the light shape breaking.

Cube map is not affected by translation and scale
The translation and scale on the environment cube map are not taken into 
consideration by the hardware renderer. The cube map will render very 
differently compared to software rendering. There is no workaround for this 
limitation. 

Hardware renderer performance is slow when baking projected textures
The hardware renderer performance is slow when baking projected textures.

Workaround: Reduce the baking resolution (Color resolution, Bump 
resolution) in the Render Settings: Maya Hardware tab. 

Hardware renderer doesn't correctly sort transparent polys and there 
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are artifacts on transparency mapped objects 
If objects or parts of objects with different shaders have overlapping 3D 
bounded regions with respect to the camera, then the transparency sorting 
may not be as expected with respect to a software rendering. 

This is due to the fact that the hardware renderer does not sort on a per pixel 
basis. There are basically two modes for transparency sorting in the Render 
Settings:

• Per Object 

• Per Polygon 

The axis aligned world space bounding box of objects is used as the main 
criteria for depth sorting with respect the current camera used for rendering. 

For Per Object, objects are sorted from furthest to closest in depth to the 
camera. The distance measurement is from the center of the bounding box to 
the camera “look from” position. If more than one shader is assigned to an 
object, then each part of the object will have its bounding box computed. 
Each distinct part is called a shader section and the box, the shader bounds. 
If the whole object uses one shader then the shader bounds" are equivalent 
to the bounds for the entire object. The shader bounds are sorted from back 
to front. 

Per Polygon provides further sorting refinement. The polygons are sorted for 
each object from back to front. When drawing the depth-sorted shader 
bounds the polygons are drawn from back to front. If this option was not 
turned on, then the polygons would be drawn in arbitrary order per shader 
bounds.

Workaround 

For possible better sorting, the you can either:

• Split up polygons of the object into separate objects. 

• Split up single shader regions on single objects into separate objects 
with one shader per object. 

Hardware bump maps are dependent on texture resolution
The bump map appearance is dependent on the size of the mapped file 
texture, or the bump resolution and preset quality in Render Settings. If the 
resolution is changed the bump appearance will also change. 

Workaround 

Adjust the bump depth to restore the desired appearance.

Environment reflection maps must be mapped to the reflected color 
channel

Sphere and cube environment maps are only supported on the reflected color 
channel. Assigning one to another channel will produce undefined results. 

BOT files are not supported by the hardware renderer 
BOT file textures will be rendered black by the hardware renderer. 
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Hardware renderer clipping planes deviates from the default behavior of 
the software renderer and the mental ray renderer 

For the software renderer and the mental ray renderer, if part of an object is 
beyond the far clipping plane, the entire object is rendered, including the part 
beyond the far clipping plane. 

However, for the hardware renderer, if part of an object is beyond the far 
clipping plane, then only the part of the object that is in front of the far 
clipping plane is rendered. Parts of the object that is beyond the far clipping 
plane is clipped and not rendered.

ATI Ashli hardware shader plug-in unstable on 64-bit Linux
The ATI Ashli hardware shader plug-in is unstable on 64-bit Linux, and can 
cause Maya to crash when loading in shader files for display. 

Shadows broken with newest version of Cg on nVidia cards
(Windows, Linux) We have supplied the beta 2 version of the Cg 1.5 libraries. 
Shadows do not work properly with later versions of these libraries on nVidia 
cards (on all platforms). ATI cards do not appear to have this problem.

(Mac OS X) Because a universal binary library version is required, we have 
supplied the 1.5.0012 version of the Cg libraries. On nVidia cards using Mac 
OS X 10.4.8, shadows do not render properly.

You can replace the Cg libraries in the run-time area with new versions for 
CgFx plugin shader development. However, we do not qualify or support 
newer versions of the libraries (for example, they will show this shadow 
problem). 

Hardware renderer limitation with texture mapped to transparency 
channel 

The hardware renderer does not support connecting a greyscale texture's 
outTransparency attribute to a shader's transparency channel. 

Workaround

Use outColor instead of outTransparency. 

Same texture placement must be used for color and transparency
Color and transparency textures need to use the same placement.

 Hardware renderer limitation for Alpha Is Luminance flag
The hardware renderer does not support the Alpha Is Luminance flag for 
diffuse procedural textures on NV30 class hardware. 

Workaround

Use a file texture with alpha instead of a procedural.

Hardware renderer does not support point light shadows
Shadows are not created for point lights when the hardware renderer is used. 
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Vector rendering limitations
The following lists the Vector rendering limitations and workarounds.

Image is not displayed in browser when Open in Browser is on 
On Macintosh systems vector rendered images are not displayed in Internet 
Explorer 5.2 or lower when the filename is longer than twenty characters. 

Workaround

Use a newer version of Internet Explorer or another browser (for example, 
Safari, Netscape, Mozilla).

By Frame ignored in Vector rendered filenames
By Frame has no effect when using the Maya Vector renderer. 

Mac Pro does not support the vector renderer

The vector renderer is not supported on the Mac Pro platform. If you try to 
load the vector renderer, an error message occurs. 

Hardware shading limitations
The following lists hardware shading limitations and workarounds.

Projected textures or 3D texture placement on NURBS
Projected textures or 3D texture placement on NURBS surfaces may not 
reflect the correct placement in the views after you transform the shapes.

Workaround

Make an insignificant change to any of the texture’s parameters to force a 
proper update after the transformation.

Mapped 3D texture on polygonal object 
If a polygonal object has a mapped 3D texture then hardware texturing 
requires that the surface have a regular grid of unique UVs between 0 and 1 
for sampling the texture over the surface. 

Maya Software plug-in limitations in hardware shading

General limitations:
• Shader plug-ins and textures plug-ins are supported when you use 

Hardware Texturing. When you use Smooth Shade All mode, only the 
attributes of the following specific names are used: diffuse, 
hardwareColor, color, transparency, incandescence, specularColor, 
shininess. 

Default texture resolution issues
Default texture resolution issues (which can be modified by switching quality 
in the material’s Attribute Editor) include the following limitations: 
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• The 2D file texture attempts to use the full resolution (rounded to a base 
2 number) of the file, but some configurations of texture placement will 
result in the use of a 64x64 hardware texture (for example, if you set the 
Coverage to less than one this occurs). 

• All 2D procedural textures are represented by a 64x64 swatch. 

• All 3D textures are represented by a 32x32 swatch, but a dynamic 
attribute named resolution may be added to configure this setting. 

(Mac OS X) Unsupported image file formats appear in the Hardware 
Render Buffer window

In the Hardware Render Buffer window, Render > Attributes... window, 
unsupported image file formats appear in the Image Format drop-down list. 
The following are the supported image file formats: Tiff, Tiff16, SGI, MayaIFF, 
JPEG, Maya16IFF, Targa, Windows Bitmap, MacPaint, Photoshop, PNG, 
QuickDraw, and Quick Time Image.

When you select another (unsupported) format from the drop-down list, Maya 
renders the image as an .iff file.

Texturing limitations
The following lists the texturing limitations and workarounds.

Convert to File Texture and Layered Shader
You cannot use Convert to File Texture on materials that are a layer of a 
Layered Shader. 

Workaround

Disconnect the material from the Layered Shader, do the conversion, and 
then reconnect the resulting file texture to the Layered Shader.

Photoshop integration limitations
The following lists the Adobe® Photoshop® integration limitations and 
workarounds.

Show Batch Render, View Image and View Sequence do not support 
PSD format

You cannot use Render > Show Batch Render, File > View Image... (FCheck 
as the default), or File > View Sequence... (FCheck as the default) with PSD 
images.

Rendering optimizations
A node cycle detection prevents endless loops and crashes when 
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translating DG graphs
The performance impact grows with the depth of the visited shading graphs. 
The cycle detection is enabled by default, but you can disable it by adding a 
dynamic attribute nodeCycleCheck (boolean) to the render globals node. We 
recommend using the cycleCheck MEL command to detect the cycle in the 
DG graph to fix it.

Technical notes (for scenes created using Maya 6.5 
or earlier)

Changes to render globals nodes
Due to changes in the Render Settings (previously Render Global Settings), some 
attributes have changed.

The following tables outline the affected attributes for particular renderers.

Maya Hardware renderer

Previous attribute name (short name) Current attribute name

hardwareRenderGlobals.imageFilePrefix (fn) defaultRenderGlobals.filename

hardwareRenderGlobals.startFrame (sf) defaultRenderGlobals.startFrame

hardwareRenderGlobals.endFrame (ef) defaultRenderGlobals.endFrame

hardwareRenderGlobals.byFrame (bf) defaultRenderGlobals.byFrame

hardwareRenderGlobals.imageFormat (if) defaultRenderGlobals.imageFormat

hardwareRenderGlobals.imfkey (imfkey) defaultRenderGlobals.imfPluginKey

hardwareRenderGlobals.enableDefaultLight (edl) defaultRenderGlobals.enableDefaultLight

hardwareResolution.width (w) defaultResolution.resolutionX

hardwareResolution.height (h) defaultResolution.heightresolutionY

hardwareResolution.pixelAspectRatio (par) defaultResolution.pixelAspectRatio

hardwareRenderGlobals.preRenderMel (pre) defaultRenderGlobals.preRenderMel

hardwareRenderGlobals.postRenderMel (pst) defaultRenderGlobals.postRenderMel

hardwareRenderGlobals.modifyExtension (me) defaultRenderGlobals.modifyExtension

hardwareRenderGlobals.startExtension (se) defaultRenderGlobals.startExtension
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Notes

Image Format

The numbering for image format (defaultRenderGlobals.imageFormat) has 
changed. To find the appropriate numbering, do the following:

1 Set the Image format in the Render Settings window, Common tab.

2 Use the following command:
getAttr defaultRenderGlobals.imageFormat

The result is the correct numbering.

Out Format Control

The value for the out format control (defaultRenderGlobals.outFormatControl) has 
changed from boolean to a numbered value, from 0 - 2. To find the appropriate 
numbering, do the following:

1 Set the Image format in the Render Settings window, Common tab.

2 Use the following command:
getAttr defaultRenderGlobals.outFormatControl

The result is the correct numbering.

mental ray for Maya renderer

hardwareRenderGlobals.byExtension (be) defaultRenderGlobals.byExtension

hardwareRenderGlobals.outFormatControl (ofc) defaultRenderGlobals.useCustomExtension

hardwareRenderGlobals.outFormatExt (ofe) defaultRenderGlobals.customExtension

hardwareRenderGlobals.enableRenderLayers (el) (None, flag is obsolete.)

Previous attribute name (short name) Current attribute name

Previous attribute name (short name) Current attribute name

mentalrayGlobals.imageFilePrefix (ifp) defaultRenderGlobals.imageFilePrefix

mentalrayGlobals.periodInExt (peie) defaultRenderGlobals.peiodInExt

mentalrayGlobals.putFrameBeforeExt (pff) defaultRenderGlobals.putFrameBeforeExt

mentalrayGlobals.extensionPadding (ep) defaultRenderGlobals.extensionPadding

mentalrayGlobals.animation (an) defaultRenderGlobals.animation

mentalrayGlobals.startFrame (sf) defaultRenderGlobals.startFrame
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Notes

Image Format

The numbering for image format (defaultRenderGlobals.imageFormat) has 
changed. To find the appropriate numbering, do the following:

1 Set the Image format in the Render Settings window, Common tab.

2 Use the following command:
getAttr defaultRenderGlobals.imageFormat

The result is the correct numbering.

Device Aspect Ratio

Due to changes regarding aspect ratios, this attribute has been replaced by Pixel 
Aspect ratio.

mentalrayGlobals.endFrame (ef) defaultRenderGlobals.endFrame

mentalrayGlobals.byFrame (bf) defaultRenderGlobals.byFrame

mentalrayGlobals.renderableObjects (ro) defaultRenderGlobals.renderAll

mentalrayGlobals.outFormatExt (oft) defaultRenderGlobals.outFormatExt

mentalrayGlobals.outFormatControl (ofc) defaultRenderGlobals.outFormatControl

mentalrayGlobals.renumberFrames (rnf) defaultRenderGlobals.modifyExtension

mentalrayGlobals.startExtension (se) defaultRenderGlobals.startExtension

mentalrayGlobals.byExtension (be) defaultRenderGlobals.byExtension

mentalrayGlobals.preRenderMel (prm) defaultRenderGlobals.preRenderMel

mentalrayGlobals.postRenderMel (pom) defaultRenderGlobals.postRenderMel

mentalrayFramebuffer.width (w) defaultResolution.width

mentalrayFramebuffer.height (h) defaultResolution.height

mentalrayFramebuffer.deviceAspectRatio (dar) defaultResolution.pixelAspectRatio

mentalrayFramebuffer.format (fmt) defaultRenderGlobals.imageFormat

Previous attribute name (short name) Current attribute name
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Maya Vector renderer

Notes

Image Format

The numbering for image format (defaultRenderGlobals.imageFormat) has 
changed. To find the appropriate numbering, do the following:

1 Set the Image format in the Render Settings window, Common tab.

2 Use the following command:
getAttr defaultRenderGlobals.imageFormat

The result is the correct numbering.

Previous attribute name (short name) Current attribute name

vectorRenderGlobals.imageNamePrefix (inp) defaultRenderGlobals.imageFilePrefix

vectorRenderGlobals.imageFormat (if) defaultRenderGlobals.imageFormat

vectorRenderGlobals.pixelAspectRatio (par) defaultResolution.pixelAspectRatio

vectorRenderGlobals.filenameFormat (ff) defaultRenderGlobals.animation 
defaultRenderGlobals.periodInExt 
defaultRenderGlobals.putFrameBeforeExt

vectorRenderGlobals.renderLayers (rl) (None, flag is obsolete.)
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General nCloth limitations
The following lists miscellaneous nCloth limitations and workarounds.

Missing nCloth menu set
If you’ve upgraded from Maya 8.5 Complete to Maya 8.5 Unlimited, the 
nCloth menu set may be missing from the Maya interface. This is due to 
saved Maya preferences.

Workaround

Do one of the following:

• In the Menu Set Editor, select Edit > Restore Default Menu Set.

• Delete your preferences from the following location:

Windows: <drive>:\Documents and Settings\<username>\My 
Documents\maya\<version>\prefs

Mac OS X: ~/Library/Preferences/Autodesk/maya/<version>/
prefs

Linux: ~/maya/<version>/prefs.

nRigid collision display off from nRigid objects
If all the nCloth objects in a scene are cached, the nRigid collision display will 
appear one frame off from nRigid after caching the objects. 

Workaround

Add a very small un-cached nCloth object to the scene.

Removing tearable constraints
If you remove a tearable constraint from a surface using Remove Dynamic 
Constraint, the nCloth will still tear when you simulate. 

Workaround

In the Hypergraph, select and delete the polySplitVert, polyMergeVert and 
polySoftEdge nodes.

Changing the topology of an nRigid frame
If you change the topology of an nRigid object at a frame after the start 
frame, and the resulting frame has fewer vertices or faces, Maya may stop 
indefinitely if you immediately resume playback.

Workaround

Go to the start of the playback range before playing back the scene.
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nCloth caching and settling
If you create an nCloth plane that is constrained along one edge with a low 
Stretch Resistance, cache the simulation and then attempt to append to the 
simulation, the nCloth will settle further during the appended cache. 

Workaround

Set the Rest Shape of the nCloth object to Connect Input Shape to Rest 
Shape.

Smoothing and caching
If you create a low resolution model and create an nCache for it, then add a 
polysmooth and create an nCache the new smoothed model, Maya will re-
cache the old the low resolution model instead.

Workaround

After creating the new cache for the smoothed object, select Edit > Delete All 
By Type > History. Then select Geometry Cache > Import Cache to attach the 
cache of the smoothed geometry.

nCloth node display and Fields
If you turn off display of nCloth nodes or hide the nCloth shape in the scene 
then any fields applied to nCloth will no longer have an effect. 

Workaround

Display the nCloth nodes.

Weld Adjacent Borders constraint and file saving
If an nCloth object is constrained using the Weld Adjacent Borders constraint 
and the file is saved at a frame other than the start frame and then re-
opened, the re-loaded scene will not update the constraint properly during 
playback. 

Workaround

Return to the start of the playback range before saving.

Point to Surface Constraint on wrapped surface
If an nCloth object uses a mesh as a wrap deformer and then a point to 
surface constraint is created between the nCloth and the mesh surface, the 
constraint will have no affect. 

Workaround

Make the wrap shape a passive nCloth object and then create the constraint.

Deleting nRigid objects on Windows 64-bit
When you have an nCloth constrained to an nRigid object, and you delete the 
nRigid, on Windows64, Maya may crash.
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Workarounds

• Delete the constraint, then delete the nRigid object.

OR

• Save immediately after removing the nRigid object, and then open this 
file.

Topology changes during simulation
Topology changes (modifications to the mesh surface that change vertices) 
while simulating nCloth are not supported for Maya 8.5. Changing the 
topology of nCloth objects may result in collision failures.

Vertex maps and constraints
In Maya 8.5, you can only create painted vertex maps for constraints that 
connect vertices to vertices. 

Creating nCloth from referenced files
When creating cloth objects using geometry from referenced files, if you 
unload the reference and then save the file, you may see erroneous geometry 
on the reference node. 

Caching nCloth objects with changing topology
Caching produces useful results on objects whose topology does not change 
over time. Some animated modeling construction history operations result in 
topology changes over time. While you can create a cache for these objects, 
it may distort the object during playback since a constant topology is 
assumed.

Last Tool and painting nCloth
When painting nCloth property texture maps, painting cannot be reinvoked 
with the Last Tool (default hotkey “y”) function.

Component to Component constraints updating per frame
Setting the Connection Update attribute on the dynamicConstraint node to 
Per Frame, when using a component to component constraint has no effect.

Thickness map in shaded mode
When painting the collision thickness of an object with Face collisions in 
shaded mode, it may be difficult to see mapped variations in thickness.

Workaround

View your scene in Wireframe mode (Shading > Wireframe).
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Collision Thickness display
When modifying an nCloth passive collision object with the Solver Display 
(nClothShape node) set to Collision Thickness, the scene view may not 
immediately update to match your adjustments.

Workaround

Advance a frame, or rewind to the start frame to update the scene view.

Transference of downstream connections from nCloth input 
meshes to output meshes

Downstream connections from an nCloth’s input mesh are not, in general, 
transferred to the output mesh when the input mesh is turned into nCloth. 

The only exceptions are connections between the input mesh’s World Space 
values (worldMesh on the poly mesh node) and a wrap node’s Wrap Attributes 
(driverPoints on the wrap node). These connections are transferred.

Workaround

Transfer the connections from the input mesh to the output mesh manually, 
or with a script.

Negative Push Out values
Negative Push Out (nClothShape node) values are intended for objects with 
normals reversed. The current behavior only flips the sense of normal when 
the Push Out value is -1.0, or less. This makes it impossible to create subtle 
push outs on the reverse side of a surface.

Workaround

To get expected results, flip the normals on the surface, and use a positive 
Push Out value.
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General Fur limitations

Fur stamp unexpectedly renders above paintFX stroke stamps
The camera renders fur stamps above paintFX stamps unexpectedly. 

Workaround

To correct this, create a new camera and match the camera with the broken 
camera. 

Fur attached to Classic Cloth
If Fur is attached to a Classic Cloth shape and the Solver Scale value is 
changed, the Equalizer map will be generated at the initial position of the 
Cloth shape even if you specify a different Use Frame. 

PolySmooth node causes Fur to flicker
If pre-Maya 6.5 files have polygon objects with Poly Smooth applied after 
skinning, and the Smooth UVs option turned on, there will be flickering in the 
animation of rendered Fur, or the motion blur. 

Workaround

To correct this, execute setAttr smoothNode.ma 1; in the Script Editor and 
turn off Smooth UVs in the smooth node. 

This does not happen for scene files created in Maya 6.5, as long as Smooth 
UVs is turned off.

Using Chord Height Ratio can cause Fur to flip
Fur that is applied to a NURBS surface, for which Use Chord Height Ratio has 
been turned on, may flip and point in the opposite direction on some frames 
of a multi-frame render. The Chord Height Ratio attribute is located under 
Secondary Tessellation Attributes in the Advanced Tesselation section of the 
Attribute Editor. Confirm that Use Chord Height Ratio is not turned on before 
rendering. 

Fur doesn’t recognize volume light
Fur does not recognize volume lights - light emitted from a volume light will 
have no effect on the fur render. 

Rendering high resolution 
Fur runs out of memory when you render at 8K x 8K or higher resolution. 
There is no workaround. 
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Limitations when rendering Fur in the Maya 
Software renderer

Degree 1 NURBS surfaces tessellate extremely highly
Degree 1 NURBS surfaces produce extremely heavy geometry when 
tessellated for Fur, thus taking longer to process and producing large 
intermediate files. 

Workaround 

Convert the geometry to polygons. 

Fur does not render correctly in orthographic views
Fur renders at an incorrect size in the orthographic views in the Maya 
software renderer. 

Workaround

Render Fur in mental images® mental ray®.

Fur does not support Field Rendering
If Field Rendering is turned on in Maya, Fur will ignore it and render frames. 

Workaround 

Render with the By Frame value set to 0.5 and interlace in a compositing 
package.

Fur does not render at all if the camera is scaled negatively
Fur cannot be rendered with a negatively scaled camera.

Fur renders as a grid when a spotlight has a Penumbra Angle
Fur may render as a grid when a spotlight with a shadow map has a 
Penumbra Angle. 

Workaround

Set the value for Penumbra Angle to zero. Alternatively, increase the size of 
the shadow map until the grid artifacts disappear.

Fur does not support any of the 16 bit image formats
Fur does not support any of the 16 bit image formats. 

Workaround

Fur will be correctly composited when rendered to a 16 bit file format; 
however, the Fur pass itself will still be 8 bit. Set the rendered image format 
to a supported image format.

Or render in mental ray.
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Using spotlight penumbras and drop-off with fur shadowing 
Although fur shadow maps can be used with spotlight penumbras and drop-
off, the fur shadows are not affected by these values, so there is no fall-off to 
the fur shadow. The fur shadows may look too sharp at the edges. 

Fur does not support texture mapped lights
Fur does not support texture mapped lights. 

Workaround

Render in mental ray.

Using Chord Height Ration can cause Fur to flip
Fur that is applied to a NURBS surface for which Use Chord Height Ratio has 
been turned on may flip and point in the opposite direction on some frames 
of a multi-frame render. The Chord Height Ratio attribute is located under 
Secondary Tessellation Attributes in the Advanced Tesselation section of the 
Attribute Editor. 

Workaround

Confirm that Use Chord Height Ratio is not turned on before rendering. 

Maya may run out of memory when rendering Fur with very 
large shadow maps

Rendering Fur with very large shadow maps can cause Maya to run out of 
memory. 

Workaround

Reduce the size of the shadow map and/or the Hairs/Pixel value for Shadow 
Map Rendering in Fur Globals. 

Limitations when rendering Fur in mental ray for 
Maya 

Fur on instanced objects not rendering
Fur cannot be rendered in mental ray on instanced objects if Group Under > 
New Group was selected in Duplicate Options. 

Motion blur not working
If the Segments attribute is keyframed, motion blur won’t work in mental ray.
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General scene limitations
The following limitations and workarounds relate to general scene issues with 
Autodesk® Maya® Live™.

Forced to set distance value to zero
Values set as Distance Constraints in the Survey Panel sometimes get reset 
to zero. 

Workaround

Enter the desired value in the Attribute Editor or by using MEL commands.

Errors if you open a file before loading Maya Live plug-in
If you open a Maya Live file before loading the Maya Live plug-in you get 
errors. 

Workaround

Load Maya Live plug-in before starting work in Maya Live.

Resizing Live window
Some Maya Live functionality goes out of view when you resize the window to 
a smaller dimension.

Workaround

Use Maya Live in its full screen display for all options to be accessible.

Save changes prompt
Choosing Scene > New Matchmove sometimes prompts you to save 
changes—even if you have not made any changes in the scene. 

Setup limitations
The following limitations and workarounds relate to setup issues with Maya Live.

Display of Softimage image files
If the Use Cache check box is turned off, Avid® Softimage® image files that 
lack the .pic extension will not display. 

Workaround

Do one the following: rename images to include .pic extension, convert to 
another format, or turn on the Use Cache check box on the Setup Cache 
control panel. 
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Image plane streaks
Occasionally, images do not display correctly on the image plane and the 
pixels on the right side of the image appear as streaks. 

Workaround

This problem occurs when there is not enough texture memory on the 
machine. Open the Setup Cache control panel and choose None in the 
Texture Method parameter. 

Track limitations
The following limitations and workarounds relate to track issues with Maya Live.

Deleting track points
If you undo the deletion of a track point that was used in a solution, only the 
associated 3D locator reappears. 

Workaround

Choose Edit > Undo again to bring back the track point.

Manipulating track boxes
You may have difficulty selecting and resizing track boxes in the 
pointCenteredCamera view panel. 

Message from positioning track boxes
When you position a track box, the following message appears in the Script 
Editor: 

// Undo: dragTrackedPoint_doDrag //. 

Workaround

Ignore the message. 

Refresh of track point names
When you change the name of a track point or a survey constraint in the 
control panel, the label name does not change in the view panels.

Workaround

Wait for the next time the view panels refresh. 

Deselected Track Box Tool
Saving your scene deselects the Track Box Tool.

Workaround

Re-select the Track Box tool if you want to drag a point.
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Ready-to-Solve bar remains red
When you prepare to solve for object motion (using the As Object checkbox), 
the Ready-to-Solve indicators in the Track Summary may remain red. This 
occurs because the Ready-to-Solve indicators are based on camera 
solvability.

Workaround

Ignore the red indicators and continue with the Solve task. 

Solve limitations
The following limitations and workarounds relate to solve issues with Maya Live.

Undo of Start, Continue, or Refine
Errors occur if you undo the Start, Continue, or Refine step. 

Workaround

Delete the resulting solution instead of choosing Edit > Undo. 

Root Frame solver failure
Occasionally, the Root Frame solver fails and the following message appears 
in the Script Editor:

// Error;  // Exception. //  
// Error;  // Solve Failed. //  

Workaround

Click Solve or Start again and the solver will work. 

Playblast frame range
The Playblast button on the Solve control panel plays the entire frame range 
rather than the frames specified in the Solve control panel. 

Workaround

Select the frame range in the Time Slider bar instead.

Survey constraint Variance fields
The solver performs poorly if you enter a value of zero in any of the survey 
constraint Variance fields. 

Workaround

Avoid entering zero in the survey constraint Variance fields. 
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Fluid Effects limitations

Segmented Fluid Caching fails if scene file name starts with a 
number

When creating a segmented fluids cache with the One file per frame format, 
the cache creation will fail if your fluid’s scene name begins with a number 
(for example, 3dFluidSegCache.ma). 

Workaround

Rename your scene so that it does not begin with a number.

Fluids with temperature turbulence backward compatibility
If you have old fluids from 7.0.1 or earlier that use temperature turbulence, 
their simulations will play back differently each time they are played due to 
the backward compatibility settings. 

Workaround

If you don't want to keep this random behavior, run the following MEL script 
for each fluidShape that uses temperature turbulence:

setAttr fluidShape.usePre70Dynamics false;

Fluid Cache creation uses the current state as the starting point
When creating a cache for a fluid, the current state of the fluid will be used 
as the starting point for the cache. 

If you do not wish to use the current state, but want to start again from the 
initial state of the fluid, rewind to the fluid start frame. If the start frame for 
the fluid is not the same as the cache start frame, run the fluid up to the 
start frame of the cache. 

Like-named fluids cause cache problems
If you have a scene that contains 2 or more fluids, and their fluidShape 
nodes have the same name, then fluid caching will not work correctly for 
those fluids.

Workaround

Make sure that the fluid nodes in your scene have unique names if you 
intend to cache them.

MR render does not read fluid names properly
mental ray will render an animation incorrectly if fluid names are not unique. 
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Workaround

Ensure that each fluid shape in your scene has a unique name; when 
duplicating a fluid, make sure that Assign Unique Name is turned on.

Fluid texture not updating
A fluid texture does not update if not connected on outColor. When rendering 
in mental ray if the fluid is only connected on outAlpha, it does no t update.

Workaround

Insert a luminance node between your fluid texture and the shader.

Surface shaded 3D fluid with Opacity Texture looks different in 
software render

If the dropoff shape is off, or the edge dropoff is 0, and your 3D fluid has 
density (greater than the surface threshold) in the boundary voxels, you won't 
see an outside boundary in hardware draw. 

Workaround

If you need to see the outside boundary in the hardware draw, set the dropoff 
shape to cube, and the edge dropoff to .01.

2D texture collision missing some areas
The fluid doesn't enter some regions around the collision object. 

Workaround

Triangulate the poly mesh explicitly using Polygons >Triangulate. 

Fluid object doesn't render in the exported file
If you exported a fluid with inputs off, you may end up losing the fluid shading 
connection to itself, and the fluid will not render. 

Workaround

Open Hypershade, Assign the fluidShape to itself and it will render again.

Fluids cache nodes may be named incorrectly
If you create a cache or initial state for a referenced fluid or a fluid in a 
namespace, the cache nodes will be named incorrectly. For example, if you 
create a cache for fluffy:fluidShape1, the cache node may be named 
fluidShape1.

Workaround

Rename the cache node to initialState_fluidShape1 or cache_fluidShape1 as 
appropriate.

Referenced file initial state cache may be modifiable from 
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parent file
If your referenced file has an initial state cache, you can modify it from the 
parent file.

Workaround

Don’t modify it—either by painting or save initial state (unless you really 
mean to).

Floating object animation limitation
Floating object animation only works correctly if units are in centimeters.

Workaround

Look at the extra attributes on the associated locator shape, and modify to 
compensate for the change of units. The scene scale is normally used to 
match the ocean shader scale, but it can also be used to compensate for the 
units relative to centimeters. Or you can modify gravity, or some of the other 
physical constants to get the desired motion in your units.

Alpha in image plane expands when used with volume fluids
Alpha in image plane expands when used with volume fluids. 

Workaround

Make a second render.

1 Set the colorGain to zero and the color offset to 1 in the image plane.

2 On the fluid node set the Color ramp to all black and then set the 
Incandescence ramp to white.

Different blending cutoff in attribute presets for multis than 
strings, enums

If you apply an attribute preset with blending for a node that has ramp 
attributes and there isn’t a one-for-one match between the entries on the 
corresponding ramps, you may get unexpected results. If these results are 
not satisfactory, you may have to adjust the results by hand. If you undo this 
kind of blend, you may end up with an extra index entry with a position and 
value 0. If so, delete the extra entry. 

Ocean Shader: How do you create a tiling looping texture from 
it?

Here is a more detailed recipe for looping an ocean:  
LOOP_FRAMES = number for frames after which animation repeats. 

1 Create an ocean or ocean shader. Set the numFrequencies and waveHeight 
both to zero so that the ocean is totally flat and more optimal to render.

2 Map the oceanShader waveHeightOffset with an ocean texture..asProjection = 
ON and newTexturePlacement OFF. On the projection set the rotateX to 90.
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3 Map the colorOffset of this texture with another ocean texture.. asProjection 
= OFF and newTexturePlacement = OFF

4 Animate the time values of the two ocean textures such that the start of one 
is the same as the end of the other.

In the time field on oceanTexture1 type:

= frame/30   (the time parameter generally expects seconds, not frames)

In the time field on oceanTexture2 type:

= (frame-LOOP_FRAMES)/30

5 Keyframe the waveHeight on the two textures to do a cross dissolve:

oceanTexture1 frame 1 = desired height, frame LOOP_FRAMES = 0

oceanTexture2 frame 1 = 0, frame LOOP_FRAMES = desired height

The ocean animation should now loop across the number of frames specified 
by LOOP_FRAMES above. For it to work the two ocean textures must have 
identical values (apart from the wave height and time). With this method you 
cannot preview the displacement of the ocean using the heightfield node 
(convert displacement to poly will work). Also buoys and boats will not 
animate with wave height (texturing on the ocean shader is currently not 
taken into account for these effects).

Ocean horizon appearance
Large Ocean objects may appear blurry near the horizon when rendered in 
either mental ray or Maya renderers.

Workaround

Lower the horizon filter value from 1.0 to 0.1 on the ocean shader.

Ocean horizon and waves
When the camera is positioned such that a wave obscures the horizon line, a 
line artifact may appear on the wave. 

Workaround

• Make the Horizon Filter value zero on the ocean shader. Note that a 
higher antialiasing setting may be required to avoid jitter along the ocean 
horizon. 

• Render in Mental Ray. 

Volume light Emit Ambient attribute not updating in IPR
When you select Emit Ambient with IPR running, you won't get an update. 

Workaround

Reselect the area or change another attribute to update the render. 

Multiple processors for fluid rendering may result in artifacts
When using four or more processors for fluid rendering, you may experience 
artifacts. 
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Workaround

Reduce the number of processors to four or less and try again.

Multiple processors for fluid rendering may result in system 
crash

When using a multi-processor/multi-core machine for fluid rendering, you may 
experience crashes.

Workaround

Reduce the number of processors used for rendering and try again. 

Texture does not return to its original position
If your Texture Coordinate Method is set to grid and you are painting your 
fluid with autosave on, the texture does not return to its original position. 

Workaround

Rewind, change coordinate method to fixed then back to grid again. Avoid 
saving unwanted grids, make sure that your saveInitialState options are set 
to indicate which grids should be saved. 

Unexpected results when self shadowing on a surface rendered 
fluid

When self shadowing on a surface rendered fluid, you may get unexpected 
dark regions and artifacts. 

Workaround

This only happens if the fluid has no transparency. Increase the quality until 
the artifacts disappear. Alternately, set the transparency to a non-zero value 
and it behaves as expected. 

Hardware display issues with Node Caching
When Node Caching is turned on, you may get unexpected results in the 
hardware display. 

Workaround

Don't turn on Node Caching for Fluid Effects. If you did, turn it off, save your 
file, and restart Autodesk® Maya®.

Depth buffer inaccurate for surface fluid
When rendering a fluid with depth output and a surface style fluid, you would 
expect the surface to appear correctly in the depth buffer, especially if the 
fluid surface transparency is zero. By default nothing will appear in the depth 
buffer. You must set the camera depthType to the closest visible depth to 
see the fluid in the depth output. However the depth value will be the near 
intersect with the fluid bounds, rather than the actual depth of the blobby 
surface. This could create problems for composites with objects (or paint 
effects) within the fluid bounds. 
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Workaround

You can get closer to the correct depth by enabling volumeSamplesOverride 
and increasing the volume samples on the fluidShape. Note this may create 
artifacts with surface type fluids and it will take longer to render.

Fluid wireframe draw (particles) does not work if voxels too 
small

If the voxel resolution is set low, nothing appears in the Fluid wireframe draw 
(particles). 

Workaround

Use shaded mode or rectangles.

Can't create partial presets if node has multi attributes
You may want to edit the preset file so that it only contains a subset of the 
node's attributes, but when applying a preset to a node with multi attributes, 
it empties out all the multis first, and then adds entries to the multis from 
the preset. Do not alter these files, particularly the entries for any multi 
attribute, such as ramps. 

Convert Fluid to polygon full of holes with smooth interpolation
When converting a Fluid to a polygon with smooth interpolation, you will most 
likely get holes in the mesh. 

Workaround

Use linear interpolation and then average the vertices, or, with smooth 
interpolations, using fillHole will deal with these holes except when the 
boundary has non-manifold vertices. In this case we recommend increasing 
the threshold until the geometry is no longer non-manifold. 

Surface rendered 2d fluid image is not consistent with Render 
As display

A surface render of a 2d fluid may not look like a fluid in Display As mode. 

• The drop off shape for the cone (and double cone) isn't capped, so you 
still end up with the ends open. This is intentional.

• In a 2D fluid, not enough triangles are generated along the depth, so in a 
deep 2D fluid, the sphere will look like a cylinder and the cone will look 
like 2 cylinders.

• You will get ribboning if your drop off shape is off, or the edge dropoff is 
0, whatever the shape. 

Noise and volumetric objects
When using 2D textures on volumetric objects, they must be used as 
projections. 
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Older presets are not removed when Maya uninstalled
Uninstalling Maya does not remove the presets folder (in case you have 
added your own presets to it). So if you have previously installed an older 
version of Maya (for example, if you are a beta site), some old presets which 
no longer work correctly may remain in your new install. 

Workaround

Manually remove the presets folder or just the unwanted presets from your 
install location before re-installing Maya.
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Hair limitations

Stiffness Scale no longer affects curve attraction
In Maya 2008, Stiffness Scale no longer affects curve attraction. Instead, the 
new Attraction Scale ramp lets you control the value of Start Curve Attract 
along the length of a single hair clump or an entire hair system. This means 
that Hair in pre-Maya 2008 scene files that uses non-default Stiffness Scale 
values will now behave differently.

Hair width incorrect when rendered with mental ray
When rendering hair in mental ray, hair width is defined relative to clump 
width, while the Maya interactive and Software Renderer use the hair width 
directly in world space. 

Workaround

Change hair width before rendering in mental ray. If you are modifying the 
clump width per follicle with the Clump Width Mult, you may need to put 
different sized clumps into separate hair systems, or use an alternate 
method such as the Baldness Map for controlling hair placement 

IK solver may crash Hair render
If your mode has dynamic curves that affect an IK solver, it may crash when 
rendering in mental images® mental ray® on Linux®. 

Workaround

Bake the IK before rendering and make sure that the IK solver is not 
enabled.

3D motion blur on Hair 
The thinline brush type used by the internal default brush for hair does not 
support 3D motion blur. 

Workaround 

You can assign a Paint Effects brush to the hair system and use the Paint 
Brush Type (Brush Type = Paint). Keep in mind rendering will be slower with 
the Paint Brush Type and also the hairs may appear too thick when viewed 
from a distance. 

Note 2D motion blur works with hair and the ThinLine Brush Type.
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Simulation rate problems due to over and undersampling
Simulation rate does not affect hair solver oversampling, and undersampling 
dramatically changes the speed of the motion. 

Workaround

Do not over or undersample when caching hair and do not change the 
playback rate. If you change your time units, you may need to change the 
dynamic properties of your hair system to compensate.

Lock Length not working with clusters
Lock curve length does not work with cluster or other deformers. 

Undo not working when using Lock Length
With Lock Length, undo does not return curve to original position. 

Setting Rest or Start curves from Current on referenced hair 
system doesn't work

Setting Rest or Start curves from Current on referenced hair system doesn't 
work. 

Workaround

Modify Rest or Start curves in the referenced file instead.

Problems with non unique hair curve names and namespaces
If you import multiple hair systems with the same curve names using 
namespaces, set Rest Position and set Start Position will be unable to 
distinguish the curves. 

Workaround

Although we generally encourage the use of namespaces, in this case it may 
be better to import hair with prefixes to resolve clashing names.

Gravity not working with Hair
Gravity doesn't work well with Hair in Z-up system. 

Workaround

Use a gravity field instead of the built in gravity

Note Lock Length is intended for use while transforming CVs. It is not 
currently supported in conjunction with other animation techniques. 
You may wish to save before editing your curve with Lock Length 
turned on.
Autodesk Maya 2008 Release Notes

100



17 | Maya Hair
Release notes > Hair limitations
A default dynamic curve behaves differently at each end
The tip point lock locks to the end CV position, but not to end segment 
direction. 

Workaround

Apply a transform constraint at the end of the hair.

Hair jittering with collision constraint
If your collide sphere constraint is non-proportionately scaled so that one 
dimension is much thinner than another, stiff hair will jitter when touching the 
constraint. 

Workaround

Reduce the stiffness until the hair stops jittering or make the constraint more 
uniform in scale.
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Toon limitations

Lighting Based Width does not work with Offset Mesh
Lighting Based Width for toon lines is not supported for Offset Mesh profile 
lines. 

Workaround

Use Paint Effects profile lines if you need lighting based width.

pfxStrokes command does not support pfxToon node 
completely

The pfxstroke command does not output the profile curves for a pfxToon 
object. 

Workaround

Use ConvertPaintEffectsToCurves to extract the NURBS curves for the toon 
outline.

Reverse surfaces only work for polygons
When using Toon Lines with Offset Mesh for the profile lines, Reverse 
Surface is only supported for Polygons. 

Workaround

For NURBS surfaces and Subdiv surfaces, if you need to reverse the surface, 
convert the surface to polygons and create the offset mesh on the poly 
surface. For NURBS surfaces, you can also Reverse Surface Direction on the 
NURBS surface itself. 
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General Maya limitations & workarounds
The following limitations and workarounds relate to general Maya issues.

Wait cursor may display after loading files
After loading a file, a wait cursor may come up and Maya will use all available 
CPU cycles for a long time (several minutes at least). This problem seems to 
occur in files that have IK and dependency loops. 

Workaround

The ideal workaround is to find and remove the dependency loop. These 
loops may be difficult to find. For example, A may be translated by a 
pointConstraint B that uses target C that has a parent D that is rotated by an 
expression E that has an input from F that is constrained to G which is a 
child of A. One hint is to look for expressions that have outputs to attributes 
on many different nodes.

That is, some complex scenes take a long time to evaluate, and you could 
encounter this when loading a file.

Audio files may cause Maya to hang
When using imported audio files in Maya it is inadvisable to have background 
applications running that use audio capabilities.

Opening Maya Unlimited scenes using Maya Complete license
If you run Maya using a license for Maya Complete then open a scene that 
contains nodes that are restricted by licensing to Maya Unlimited, you may 
see warnings of the form:

// Warning: file: …/30Sectest.ma line 63: Unrecognized node 
type 'something'; preserving node information during this 
session. //

These warnings can be safely ignored. All information in the Maya Unlimited 
nodes will be properly imported into Maya Complete and written out again 
correctly when the scene is saved. 

If these licensed nodes came from an Unlimited plug-in (for instance, Maya 
Fur) when the scene is written out again by Maya Complete the scene file 
forgets that it needs Maya Fur to load properly. 

Workaround

Load the Maya Fur plug-in manually in Maya Unlimited before loading the 
scene file. 
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Duplicated objects not assigned to a duplicate layer
When duplicating objects with the upstream option set, the options in the 
layer creation option box (right-click layer bar New Layer, or Options in layer 
editor) are respected. 

If the Assign to Current Layer option is specified, the duplicated objects will 
not be assigned to a duplicate layer, but will instead be assigned to whatever 
layer is current. The layer itself will still be duplicated in this case but will 
remain empty. 

Script filters don’t invoke filterChanged callback
Script filters don’t invoke filterChanged callbacks when script changes, for 
example, if you create an item filter like this: 

    itemFilter -byScript userScript filter1;

If you modify the script, you will not be informed that the filter has changed.

Workaround

Reassign the same script to the filter to trigger the workaround.

    itemFilter -edit -byScript userScript filter1

Maya leaves UNIX shell key repeat turned off
Occasionally, Maya will leave your UNIX shell key repeat turned off.

Workaround

Use the xset UNIX command to turn it back on:

    xset r on

Marquee component selection in shaded mode
In shaded mode, a marquee selection will select all components inside the 
selection rectangle, even if they happen to be hidden by the shaded surface. 
In other words, shaded selection behaves the same as wireframe selection 
for components.

Editing shading group connections manually
It is not recommended that you manually try and edit the shading group 
connections.

Workaround

Instead, always use the higher level interfaces like Hypershade and shading 
groups editor to ensure the connections do not become inconsistent which 
will result in the surface not appearing when rendered.
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NURBS surface does not appear when rendering
If a NURBS surface is disconnected from its shading group it will continue to 
be drawn in shaded mode but will not appear when rendering. This is 
different from polygon objects which will not appear in shaded mode in this 
situation.

Double transformation when objects parented with history
When an object is parented with its construction history the output surface 
may get a double transformation when the group is moved.

Workaround

To fix this toggle the inhertsTransform flag (on the surface) to off. This stops 
the surface from inheriting the group’s transformation and fixes the problem. 
Note: the group command automatically detects and toggles this flag in these 
situations but the parent command does not.

Revolved surface limitation 
If a revolved surface is grouped with its input curve then transforming the 
resulting group will change the shape of the revolved surface since the 
revolve node’s pivot will not be transformed.

Workaround

This can be avoided by not grouping the curve with the surface or by creating 
a locator under the group and connecting its position to the revolve node’s 
pivot.

Transform with multiple surfaces
If a transform has multiple surfaces under it the shape node may have to be 
selected in the outliner for commands like makeLive to work properly.

Cycle checking may miss a cycle
The cycle checking that happens during attribute evaluation may miss a cycle 
in which incoming connections on a DAG node form a cycle that includes any 
of the worldspace attributes on its child nodes. 

Workaround

cycleCheck NODE can be used to detect these cycles if you suspect this to 
be the case.

Loss of shader assignment for polygonal objects
While dealing with polygonal objects, deleting dag nodes that are part of the 
history of the polygon could lead to the loss of shader assignment. This 
happens only when materials have been assigned to faces (as opposed to 
the whole object). The result would be that all the faces of the polygon will 
end up in the default shading group and material assignment will have to be 
redone.
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Edit > Duplicate does not work on isoparms
Workaround

Use Edit Curves > Duplicate Surface Curves instead.

Maya does not read previous version’s windowPrefs.mel 
Maya will not read the previous version’s windowPrefs.mel file as the window 
sizes have changed for some of the windows. If Maya recognized the old 
preferences, it could hide new functionality. 

Referencing or importing a file from the command line whose 
name is not a legal identifier

You cannot reference or import a file from the command line whose name is 
not a legal identifier unless you explicitly use the -rpr or -ns flags. This 
includes files whose file name begins with a number. 

Workaround

• Use the -rpr or -ns flags to explicitly specify a valid renaming prefix.

• Rename the file to something starting with a letter (for example, 
a107953.sph.ma).

Grid -style warning from uiConfiguration script
It is safe to ignore the warning message when the -style flag is used for 
loading old Maya scene files. The warning message is a result of improving 
the functionality of the grid command. As a result the -st/style flag is 
obsolete. Saving and loading Maya 4.0 or later files will not generate this 
warning message. 

UV values with no history may not be retrieved properly when 
file referencing

Tweaked UV values on polygonal geometry with no history may not retrieve 
properly in cases where that geometry comes from a referenced file. 

Workaround

Introduce some minimal and benign construction history on the object in its 
referenced file. For example, open the referenced file in Maya and perform a 
Move Component with construction history enabled on a vertex, without 
actually moving the vertex.

Windows 2000 problem with mapping project directories
On Windows 2000, there are problems if you create a mapped drive that you 
want to use as a project directory, and the destination of the mapped drive is 
the root of another. For example, your “scenes” directory of a project 
hierarchy is in X:\scenes or \\machineName\Share\scene and you map it to 
a local drive later, you will get errors when trying to open files from this 
mapped drive. 
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Workaround

Move the all the files in the “project” (that is all the files and directories at 
the same levels as the scenes directory) down one level. For example, make 
a directory called “project” and move all the files into it.

Dynamic compound attribute
If you add a dynamic compound attribute to a node with other dynamic 
attributes, and then delete the compound attribute, you will not be able to 
recreate another dynamic attribute with the same name. 

Workaround

Do one of the following:

• Save your scene and reload it. 

• Duplicate the object, delete the original, and rename the duplicate to 
match the original.

Translator limitations 
The following limitations and workarounds relate to translator capabilities of 
Maya.

MayaToAlias and StudioImport limitations

(MayaToAlias) Triangulate faces with holes 
If you want to export a Maya mesh to a wire file and this mesh contains a 
face which has hole(s) in it, you need to triangulate this face first.

(StudioImport) DOF camera settings are different in Maya after 
translation

DOF camera settings are different in Maya after translation.

(studioImport) Light with colored texture textures fog within 
Maya

When Maya renders (or raytraces) light fog on a light with a colored texture 
channel, the fog receives that texture, whereas in Studio it does not. 
Importing Studio files with lights that have colored texture channels can 
cause confusing results because the default sampling rate is 1. Try using 20 
to 30 samples. 

(StudioImport) Ortho cameras not translating correctly
Ortho Cameras are not fully supported in StudioImport. 
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Workaround

Change Include cameras to false for import. Or adjust the translation of ortho 
cameras manually after import.

(StudioImport) No refraction jitter with StudioImport
No refraction jitter in Maya renders after import from StudioImport. 

(StudioImport) Studio linear and volume lights translating 
incorrectly to Maya

Area and Linear lights are not transferred correctly. 

(StudioImport) Environment fog translated incorrectly
Only the simplest forms of Environment fog are translated correctly. 

(StudioImport) Stitched nurbs imported into Maya lose light 
linking

Working with shells from Studio can cause problems with light linking and 
rendering. 

Workaround

Unstitch in Studio before importing wire file into Maya.

(StudioImport) StudioTools aim constraints have different axes 
In StudioTools, if the aim constraints on one object have different axes, when 
they come into Maya, they will share the same axis—the one used by the 
first aim constraint on your object.

(StudioImport) StudioTools faces become trimmed surfaces 
StudioTools faces become trimmed surfaces when brought into Maya. 
Sometimes, the trimmed surface may look different than the original face.

(StudioImport) srand (seed) replaced by rand (seed) when 
translated into Maya 

If you use function srand(seed) in your expression, it will be replaced by 
rand(seed) when the expression is translated to Maya.

Workaround

Please replace “rand(seed)” with “rand(1)” if you want a random number 
from 0 to 1. If you do want to change the seed of the random number in the 
expression, please use the “seed” function which is available in Maya.

(StudioImport) Texture mapped onto color in StudioTools 
becomes image planes on all renderable cameras

The texture mapped onto the color of the StudioTools environment becomes 
image planes on all the renderable cameras. The size of this image plane is 
not necessarily correct. 
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Workaround

Adjust its size to get the desired result.

(StudioImport) Light glow transfer not perfect between 
StudioTools and Maya

The transfer of light glow is not perfect between StudioTools and Maya. The 
two main components are the light intensity and light decay. If your 
StudioTools light intensity is 1.0 and light decay is 0, then you do not need 
to be concerned.

Workaround

To get a perfect match between StudioTools and Maya light glows, just adjust 
your Maya glow intensity to:

glow_intensity = original_glow_intensity * light_intensity / 
decay

where decay is:

• 1 if no decay

• light_decay if decay is 1

• light_decay**2 if decay is 2

• light_decay**3 if decay is 3

(StudioImport) Layered shader created in Maya for layered 
StudioTools shaders

If several shaders in StudioTools are layered on an object, a layered shader 
is created explicitly in Maya for these shaders.

(StudioImport) StudioTools image plane placement
For StudioTools image plane placement to correctly convert, set the Persp 
window in StudioTools to the same resolution as the default render 
resolution, and also choose Screen as the image space type.

(StudioImport) Backdrop image and texture on background 
color in StudioTools conversion limitation 

Both the backdrop image and the texture on the background color in the 
StudioTools environment are converted to image planes on the renderable 
cameras. The depth of the image plane for the backdrop image is set to 90% 
of the far clipping plane. The depth of the image plane for the background 
color texture is set to 95% of the far clipping plane.

(StudioImport) Losing animation sequence number during 
conversion

The animation sequence number appended to the end of the image filename 
in StudioTools could be lost in Maya during the translation.
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(StudioImport) StudioTools start/end mode in render settings 
conversion limitation

The start/end mode in the render settings does not translate properly into 
Maya, as Maya has no such mode. In this mode, the start and end frames, 
when transferred to Maya, may end up very different from the range in 
StudioTools.

Obj limitations
The following limitations and workarounds relate to Obj.

.obj suffix on obj filename necessary
You need a “.obj” suffix on the filename for Maya to recognize it as an obj 
file.

Workaround

Append .obj to the end of the filename.

MTL textures
MTL textures only work with file textures.

OpenFlight limitations
The following known issues relate to OpenFlight:

• OpenFlight geometry will only accept textures assigned to the color channel. 

• Light Sources cannot be exported. Currently a single ambient light is always 
exported.

• An attempt is made to map Eye Points to Cameras in Maya; however, the 
mapping appears incorrect in some cases. Eye points are not exported from 
Maya.

• Track Planes are not supported.

• The only way to freeze a DOFs co-ordinates from within Maya is to export the 
scene as an OpenFlight file and then read it back in.

• Articulations on group nodes are not supported.

• Maya’s LODs need to be extended to better handle the flexibility of the 
OpenFlight LODs.

• If you perform a Freeze Transformations on a translated Light Point, Maya 
versions older than 4.0.3 will crash. This can be fixed by updating to Maya 
4.0.3 or higher.

• File textures may only be applied to the color attribute of a Maya shader. 
Textures applied to other attributes are ignored.

• Normals on faces are ignored on import. Maya regenerates the normals 
based on the vertex ordering. However edge settings are preserved.
Autodesk Maya 2008 Release Notes

112



19 | Miscellaneous and translators
Release notes > IGES import and export
IGES import and export

Level Mapping is not working on export
When using IGES export, level mapping (layers) is not supported. 

Additional transform nodes are created for trimmed surfaces
When using IGES export, trimmed surfaces can be exported with extra 
transform nodes. 

Non-planar planes not imported
Some systems, namely CATIA V5, write out non-planar plane entities. This is 
not currently supported by our IGES import. 

Miscellaneous translators

Compression not working using VRML2, OpenInventor export
To use compress in Export Vrml2 and Export OpenInventor please ensure that 
a zip utility such as gzip is installed and in the path on your machine.

Platform-specific limitations

Maya for Windows limitations
The following limitations and workarounds relate to Maya for Windows issues.

(Windows) Deleting menu items from tear-off menu on Maya
Deleting a menu item from a menu that has been torn off will cause Maya 
(for Windows) to crash. 

Maya for Linux limitations
The following limitations and workarounds relate to Maya for Linux issues.

(Linux) getModifiers command doesn’t seem to work on Linux
Maya for Linux may not recognize the Ctrl+click key/mouse sequence. 

(Linux) Linux and GNOME and mouse pointer as black “X”
Sometimes when you right-click and the mouse pointer becomes a black “X” 
it remains so for the Maya session and even after restarting Maya. 

Workaround 

Set the environment variable MAYA_MMSET_DEFAULT_XCURSOR; the value does 
not matter. If this variable is set, Maya will set the cursor to the left pointing 
arrow Cursor on exiting the Marking Menu/Hotbox. 
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When exiting the hotbox with the workaround already in place, the cursor may 
remain as the right-pointing red arrow. To remedy this, right-click the scene 
after exiting the hotbox. The cursor becomes the default left-pointing black 
arrow. However, the red arrow won’t show up again when you enter the 
hotbox until you log out and log in again.

(Linux) Linux and GNOME and Marking Menu/Hotbox
When using GNOME window manager on Linux, on exiting from the Marking 
Menu/Hotbox the cursor may be reset to the default desktop "X" cursor. 

Workaround 

Set the environment variable MAYA_MMSET_DEFAULT_XCURSOR; the value does 
not matter. If this variable is set, Maya will set the cursor to the left pointing 
arrow Cursor on exiting the Marking Menu/Hotbox.

When exiting the hotbox with the workaround already in place, the cursor may 
remain as the right-pointing red arrow. To remedy this, right-click the scene 
after exiting the hotbox. The cursor becomes the default left-pointing black 
arrow. However, the red arrow won’t show up again when you enter the 
hotbox until you log out and log in again.

(Linux) Display differences—with/without hardware overlays
What is displayed as red with hardware overlays is displayed as gray and 
black on cards without hardware overlays.

If there are no hardware overlays, plug-ins written assuming overlays will 
probably not work as expected.

(Linux) Dragging and dropping
Dragging and dropping from the desktop to Maya may not work.

(Linux) Window sizes
Some windows may have no height or width initially. Also, a window’s default 
size may prevent option menus from being visible and readable.

Workaround

This usually occurs the first time the window is opened when its size has not 
been previously set. Resize the window manually. 

(Linux) Interface Preferences settings for Show Title Bar in Main 
Window and In Script Editor

(Window > Settings/Preferences > Preferences > Interface) The states of 
these window’s title bars are not affected by the settings in the Interface: 
General Interface Preferences window.

(Linux) Changing system font display settings
You cannot edit the font display in Maya Linux using the system font settings.
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Workaround

You can edit the MayaScheme file in /usr/autodesk/maya/app-defaults/ 
to modify the additional X resources used by Maya to change the system font 
display settings. This file is searched in the following location order:

$HOME/app-defaults/MayaScheme

/usr/lib/X11/app-defaults/MayaScheme

$MAYA_LOCATION/app-defaults/MayaScheme

To list available fonts, use the xlsfonts command. Alternatively, you can use 
the xfontsel command to generate a font string.

See also “Using the MayaScheme file to set fonts, font sizes, and colors” in 
the Linux chapter of the Installation and Licensing guide.

(Linux) Maya windows disappear
Depending on the window behavior defined in the Window Manager control 
panel, windows may automatically raise (come to the front) on focus or when 
clicking in them. This may result in Maya child windows to disappear. They 
have been pushed down, and the new window is brought forward.

Workaround

Change the default settings for the following:

• For KDE, and Gnome, see ”Additional Linux Notes” in the Installation and 
Licensing guide.

(Linux) Putting menu items or option windows on the shelf
When you post a menu in Maya, then press Shift+Ctrl+Alt and click a menu 
item or option window to put it on the shelf, nothing happens.

Workaround

Use the Shift+Alt-right mouse button instead. 

(Linux) Maya for Linux does not support creation of movie files
Maya Linux does not support creation of movie files. This prevents certain 
other functions, such as Playblast, from working. This also means that Maya 
Live pointblasts cannot output in movie format. 

Playblast can still output a series of images and play it back using FCheck.

(Linux) Menu items do not seem to be selected
If you click an extended tab panel to show the pop-up menu on a tab panel 
(as in the Attribute Editor), the cursor appears just inside the left edge of the 
menu but no menu items are highlighted. The item beneath the cursor is 
actually selected, but it is not highlighted.

Note You must have root permission to edit the MayaScheme file when it 
is located in the /usr/lib/X11 or $MAYA_LOCATION directory. 
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Workaround

Move the cursor slightly to the left to deselect the menu, then go back to the 
menu and select a menu item.

(Linux) Option sub-menus not always visible
Sometimes file placement dialog boxes do not display option sub-menus in a 
readable or visible form. 

Workaround

Try manually resizing the dialog boxes so the option sub-menu is completely 
visible.

(Linux) Blank Getting Root Frames progress window
When you solve in Maya Live with the Gnome window manager, the first 
Getting Root Frames progress window goes blank and stays in the screen as 
long as Maya is running. This blank window is present in all applications. 

Workaround

After the solve is complete, save the scene and restart Maya to remove the 
blanked out portion of the screen. Alternatively, you could use a different 
window manager than Gnome. 

(Linux) Input connections do not appear in Hypershade
In Hypershade, when you connect a node1 output to a node2 input, the full 
menu list of input connections does not appear when you click the node2 
input arrow. 

Workaround

Click the node2 image itself instead of the input arrow. The full selection is 
then listed.

Maya for Mac OS X limitations
The following limitations and workarounds relate to Maya for Mac OS X issues.

(Mac OS X) Snapping gets stuck
When holding down any key to enable snapping (for example, v, c, or x) 
snapping may remain active after the hotkey is released. 

Workaround

Click the middle-mouse button again without the hotkey held down. 

(Mac OS X) G4/Hardware rendering support
In our efforts to take advantage of recent improvements in the graphics cards 
available on the Mac, it was necessary to make changes that prevent the use 
of hardware rendering on machines with G4 processors.
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All other Maya functionality available on Mac OS X functions properly on a G4-
based machine; however, if you attempt to use hardware rendering, you'll get 
a warning message that hardware rendering is not supported. 

(Mac OS X) Blank screens in the scene view
Selecting the four view pane layout may result in the scene views not 
refreshing properly and the view appearing blank.

Workaround

Select the four view layout a second time, or click in one of the panes to 
refresh the view. 

(Mac OS X) Symlinks have been removed from /usr/sbin
In previous versions of Maya, symlinks to licensing software and Maya 
command-line software were installed in /usr/sbin so that users could just 
type the name of the command at the Terminal (/usr/sbin/ is included in 
the default path).

These symlinks have been removed, as they caused problems when multiple 
versions of Maya were installed or when uninstallation took place.

To get access to these command-line functions, either give the fully-qualified 
path within Terminal, or use the custom Terminal (.term) provided with Maya.

(Mac OS X) Hotkeys conflict with Exposé
Exposé hotkeys (F9, F10, F11) may conflict with preset Maya hotkeys. If you 
experience this problem, you can change the Maya hotkeys, or change the 
Exposé hotkeys in the System Preferences panel of the computer running 
Mac OS X.

(Mac OS X) Default location to install plug-ins
Maya for Mac OS X provides a default location where you can install plug-ins:

/Users/Shared/Autodesk/maya/2008

See also “Load or unload plug-ins” in the Basics guide.

(Mac OS X) Features for Mac OS X not available for Windows or 
Linux

The following features are available in Mac OS X but not Windows or Linux 
versions of Maya.

• Tear-off menus in Hot Box

• Posting menus in Hot Box

• QuickTime integration

• Threaded sound playback in time line during scrubbing

• AppleScript executes Maya MEL commands with results returned. (See 
also ”Calling MEL from AppleScript and vice-versa” on page 91 of the 
MEL and Expressions guide.)
Autodesk Maya 2008 Release Notes
117



19 | Miscellaneous and translators
Release notes > Maya for Mac OS X limitations
3rd party programs not available for Mac OS X

• Motion capture drivers

Limitations of Maya for Mac OS X

• Ability to read in pre-Maya 3.0 files

(Mac OS X) Transferring files between platforms
Mac OS X files use different line endings than UNIX or Windows files. 
Mac OS X programs accommodate this by accepting any line ending, but 
Windows and UNIX programs require only their own form of line ending—
including the UNIX-like programs run from the Mac OS X Terminal window. 

Two UNIX utilities, which you run from the Terminal window, are included in 
the Maya bin folder to help you easily transfer files from one platform to 
another: tounix and tomac. 

The following table describes what you need to do to transfer files between 
specific platforms.

From To Requires

mayaBinary on OS X Any platform Put as a binary file using ftp from the Terminal 
window, the Fetch application in binary mode, 
or any other Mac OS binary mechanism; or 
Use AppleShare IP on the non-Macintosh 
platform to transfer as a binary file from the 
Mac OS. (Using ftp from the non-Macintosh 
platform corrupts the file.)

mayaBinary on UNIX 
or Windows

Maya Get as a binary file using ftp from the Terminal 
window, the Fetch application in binary mode, 
or any other binary mechanism; or 
Use AppleShare IP on the nonMacintosh 
platform to transfer as a binary file from the 
Mac OS. (Using ftp from the nonMacintosh 
platform corrupts the file.)

mayaAscii or mel files 
on UNIX or Windows

Maya No special handling

Maya mayaAscii or 
mel files

Maya 5.0+ on UNIX 
or Windows

No special handling

Maya mayaAscii or 
mel files

Mac OS X 
applications that 
read text files

No special handling
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(Mac OS X) Mac OS X file fails to open on Windows XP
A reliable way to transfer Maya ASCII files between Macintosh computers and 
other platforms running Maya is to use ftp in ASCII mode. 

(Mac OS X) Can't use a back slash code in MEL (Korean and 
Japanese systems only)

Workaround 

Type the string on the same line (do not use a back slash to carry the string 
to the next line).

(Mac OS X) Texture placement manipulator disappears
The Texture Placement manipulator disappears when you make placement 
changes.

Workaround

Click with the middle mouse button anywhere in the empty space of the 
scene view to get back the manipulator 

(Mac OS X) Interacting with Speed buttons in Fcheck has no 

Maya mayaAscii or 
mel files

Mac OS X UNIX 
applications (for 
example, vi or grep)

Use the tounix utility. From the Terminal 
window, enter:

tounix scene_file.ma

Maya mayaAscii or 
mel files

Maya 3.0 on UNIX or 
Windows

a) From the Terminal window, use the tounix 
utility: tounix scene_file.ma 
then ftp as an ascii file.

or

b) Use the interactive Macintosh application 
Fetch, in ascii transfer mode.

mayaAscii or mel files 
that have been run 
through tounix utility

Mac OS X 
applications that 
read text files

Use the tomac utility. From the Terminal 
window, enter:

tomac scene_file.ma

mayaAscii or mel files 
that have been run 
through tomac utility

Maya No special handling

mayaAscii or mel files 
that have been run 
through tounix utility

Maya No special handling

From To Requires
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effect
In Fcheck, when Every Frame is on, interacting with the Speed buttons (-, +) 
has no effect on the playback speed.

(Mac OS X) Folders in the project folder beginning with a bullet 
character cause Maya not to start

If you have a folder in your /Users/username/Documents/maya/projects 
folder that has a bullet character (option 8) in its name, Maya will not retain 
the project as it is set. It will return to the default the next time Maya is run.

Workaround

Remove the problem folder or rename it and restart Maya.

(Mac OS X) Display problem when selecting isoparm of NURBS 
surface

A strange pattern may display when you select an isoparm of a NURBS 
surface.

Workaround

Select the isoparm again to remove the pattern.

(Mac OS X) Tabbing doesn’t always work as expected in Add 
Attribute window

Tabbing in the Add Attribute window (in the Attribute Editor, select Attributes 
> Add Attributes), does not always work as expected.

(Mac OS X) 2D textures on volumetric objects
When using 2D textures on volumetric objects, they must be used as 
projections.

(Mac OS X) Turning on Emit Ambient volume light attribute 
does not update the IPR render

Turning on Emit Ambient in the volume light Attribute Editor does not update 
the IPR render.

Workaround

If you change the status of Emit Ambient, you have to modify another 
attribute of the volume light to get the ambient light to update correctly in 
IPR. From that point on, the ambient component of the volume light will 
display correctly in IPR.

(Mac OS X) You must press the set focus hotkey (Alt ‘) twice to 
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change the focus
If "Alt `" is used as the hotkey to set focus to the numeric input field, then it 
must be pressed twice to set the focus to the numeric input field. However, if 
another hotkey is used (instead of "Alt `") to accomplish the same 
functionality, then pressing the hotkey combination once is sufficient.

(Mac OS X) Maya may not find the shader library
The name of the Shader Library changed in Maya 7 and subsequent versions 
of Maya. See “Installing the Maya Shader Library” in the Installation and 
Licensing Guide for details.

There are a couple of circumstances where you may find a mismatch 
between the location of the Shader Library and the shader library location 
environment variable that is set for you. This may result in an error when you 
open Hypershade.

If you installed the Shader Library before Maya 7 and did not migrate your old 
preferences to Maya 7 or Autodesk Maya 8, Maya is looking for 
shaderLibrary when the old name is Maya Shader Library.

If you installed the Shader Library in Maya 7 or Autodesk Maya 8, and did 
migrate your old preferences (pre-Maya 7), Maya is looking for Maya Shader 
Library when the new name is shaderLibrary.

Workaround

Rename the Shader Library to shaderLibrary or Maya Shader Library as 
needed. The shader library is located in:

/Users/Shared/Autodesk/maya/

(Mac OS X) Empty parent folder removed during uninstall
If there is an empty parent folder that is a parent of the Maya install folder, it 
is removed during uninstall. For example, if the Maya2008 folder is the only 
folder inside the Autodesk folder within Applications, the Autodesk folder 
is also removed during uninstall. 
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Maya commands limitations

General

Menu bar layouts
Menu bar layouts are not visible until a child control is added.

Workaround

Create the menu bar layout and children and then show the window. 

MEL

Using a string as an integer may crash Maya
Maya may crash if you source a MEL script that tries to operate on a string 
as an integer. 

MEL array limitation
When a MEL array is specified using the {} notation then the type of the array 
is inferred from the first argument in the array. Therefore, an array declared 
with an integer as its first argument will generate a warning if a float value is 
specified later. These values will be converted to integers. Here is an 
example:

float $arr[] = { 1, 2.5 }; 

// Warning: Casting from float to int may result in a loss of 
precision. // 

print($arr[0] + “ “ + $arr[1] + “\n”); 

1 2

The value of the second element in $arr is 2, not 2.5 as expected.

Workaround

Make sure you declare the first element of the array as the type that you 
want the array to have. In the case above, this would mean declaring the 
array as: 

 

float $arr[] = { 1.0, 2.5 }; 

 

By declaring the "1" as "1.0", the type of the array is 
indicated to be float. 
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Polygon create command texture flag is no longer supported
The -texture flag (-tx) for the polygon create commands is no longer 
supported as of Maya 8.0. The -createUVs flag (-cuv) should be used 
instead. 

Using a dash in MEL strings
If the first character of a string begins with a dash, the MEL interpreter 
assumes it is a command flag. 

However, this is now a specific case where you can use strings that begin 
with dashes in MEL commands: the setAttr command can now set an 
attribute of type string with a value string that begins with a dash. 

We strongly recommend against using strings in MEL that begin with dashes 
because they will not work in any other command. If you try to use these 
strings as attributes in any other command, you will get incorrect results.

stringArrayIntersector
In batch mode, the MEL function stringArrayIntersector does not work. 

Python

Script editor cannot source .py file
Attempting to source a .py (Python) script in the Script Editor (File > Source 
Script) returns errors, as it is being read as MEL.

Workaround

Use the import directive. The script must be in your PYTHONPATH or 
sys.path. 

The script node does not accept Python
You cannot use Python in script nodes.

Workaround

Write your Python script in a .py file and save it in your scripts directory. Use 
the MEL command below in a script Node.

python("\ 
\ 
import myPythonScript;\ 
myPythonScript.pyCommand();\ 
\ 
"); 

Can't import a Maya Python module twice in Toxik 
There is a known issue that prevents Toxik from importing a Maya Python 
module a second time in a new Python embedded interpreter. 
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Runtime commands from Python and hotkeys

Menu items that are runtime commands from Python don’t display 
hotkeys.Python commands in menuItems on the Shelf produce 
an error

Python commands attached to menuItems that are part of Shelf buttons 
produce an error when Maya is restarted. Although this works the first time 
around, because it is being created with the menuItem command (-command 
flag is SCRIPT type), the second time it is being created in the saved 
shelf.mel file, with the shelfButton command whose -mi flag takes the 
String String (multi-use) arguments.

Workaround

1. Wrap your Python commands in the MEL python command:

mc.menuItem(checkBox = True, label = "menuItem 1", command 
="python(\"print 'MENU ITEM 1 PRESSED'\")")

mc.menuItem(checkBox = True, label = "menuItem 2", command = 
"python(\"print 'MENU ITEM 2 PRESSED'\")")

2. Keep a Python script in your local maya/scripts folder that has the 
functions you want to call from the Shelf:

"python(\"import shelfScripts;shelfScripts.thisFunction();\")" 

You must restart Maya once you add the Shelf commands, before you use the 
menus. Python runtime commands produce an error

Python runtime commands do not find their procedures when Maya is 
restarted; the are being incorrectly interpreted as MEL commands. 

Workaround

1. Wrap your Python commands in the MEL python command.

2. Keep a Python script in your local maya/scripts folder that has the 
functions you want to call from the runtime command:

"python(\"import myRunTimes;myRunTimes.thisFunction();\")"

When you re-start Maya, Maya uses the MEL interpreter and correctly executes 
your functions. Missing Python modules from 64-bit systems

The following modules are not included in 64-bit distributions of Python 
(Windows and Linux):

audioop, imageop, rgbimg

For more information, see svn.python.org/projects/python/trunk/README
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File formats limitations

Sets on .obj files imported into Maya considered shading 
groups

All sets on .obj files imported into Maya are considered shading groups. This 
means that adjustment of an object’s rendering groups within Maya causes 
simultaneous modification of the membership of the sets that were imported 
from the .obj file. 

Workaround

In Maya, for each .obj file set whose membership you wish to preserve, 
select the contents of the set and create a new set. 

Importing Adobe Illustrator 9.0 eps files into Maya
Importing an Adobe illustrator 9.0 eps file into Maya results in a transform 
node, but there is nothing in the view. 

Workaround

In Adobe illustrator 9.0, save as an eps file and specify that it be in Adobe 
Illustrator 8.0 format.

File referencing limitations

File referencing architecture updates for Maya 6.5 and 
subsequent versions 

Due to architectural changes that were made to file referencing in Maya 6.5 
and subsequent versions, the file format used to represent the referencing 
information has changed drastically. We have gone to great lengths to ensure 
that there will be no backwards compatibility issues when opening an older 
Maya file (pre-Maya 6.5) containing references in Maya 6.5 and subsequent 
versions. If any issues are still encountered, the following workaround may 
assist in resolving backwards compatibility issues.

Workaround

Open the file in Maya 6.0, unload all the file references, save, and then re-
open the file in Maya 6.5 or a later version. 

Proxy references do not support renaming prefixes
Renaming prefixes do not work with proxy references for name clash 
resolution.

Workaround

Use the namespace option when working with proxy references.
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Nodes and namespaces cannot share the same name
If a node and a namespace have the same name, an error is generated. 
Maya will attempt to fix this error by adding a suffix to a node whose name is 
the same as the namespace.

Workaround

Rename either the node or the namespace to ensure they are unique. 

Namespaces and loading of referenced nodes
Maya always loads referenced nodes into a temporary namespace, then 
moves them into their permanent namespace. Therefore, the name returned 
by the node added callback is different than the name returned by the node 
removed callback.

Workaround

In order to track nodes consistently, you must use the nameChanged 
callback to find the name of the object after it has been put in its permanent 
namespace. 

Referencing multiple scenes that contain mental ray data 
produces unexpected results

Referencing multiple scenes that contain mental ray for Maya data may 
cause the following issues:

• The Script Editor displays multiple warning messages regarding already 
connected nodes when the referenced files are loaded.

• Rendering the scene produces an image based on unexpected render 
settings.

Maya does not correctly distinguish between the shared nodes that exist for 
mental ray Render Settings. Each time a reference within one of these nodes 
is loaded, it applies the setAttrs and connectAttrs from that file to the shared 
node. The mental ray for Maya Render Settings that result will depend on the 
last reference that gets loaded.

Workaround
• In Maya, set the same Render Settings for each file you intend to 

reference for your scene.

• Reference the files into your parent scene, ignoring the warning 
messages.

• Confirm the mental ray for Maya Render Settings prior to rendering.

When a reference is locked, animation on compound attributes, 
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such as translate and rotate, may not play back.
Workaround 

If you need the animation for feedback, but want to make sure that the 
reference is not accidentally modified, you can customize your locking by 
adding the parent compound attributes to the Excluded attributes script. 
Alternatively, instead of locking the reference, you can put it in a display layer 
with the appropriate settings to avoid accidentally selecting it. 

Export As Reference not working with file references containing 
multiple layers

It is not possible to Export As Reference multiple objects from a scene where 
multiple layers exist.

Workaround

Remove the multiple layers and export the objects as references and 
reassign the layers afterwards.

Poly mesh geometry must have construction history to be 
modified within the parent scene

If you reference a scene containing a poly mesh and perform modifications to 
that mesh from within the parent scene, those modifications will not be 
respected unless the poly mesh had an existing construction history before it 
was referenced.

Workaround

Ensure that any referenced poly mesh geometry has at least one history node 
in the referenced file prior to referencing.

Reference edits may be lost when using identical node names
In order to apply an edit to a node from a reference it must be able to 
uniquely identify the node. In the following case this is not possible:

• Using renaming prefixes and you add a node to the parent file that has 
the same name as the renaming prefix and the reference node name.

Workaround

Make sure the names of your nodes are unique before you start applying 
edits in the parent scene.

Hypergraph layouts of objects from referenced files ignored
The Hypergraph layouts of objects from referenced files are ignored when the 
file is referenced. 

Workaround

Make any adjustments to the layout of the objects in the referencing file. 
Keep your Hypergraph closed when importing/referencing, and then clean up 
afterwards.
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Expressions and back-quoted commands limitation
If a referenced or imported file contains expressions and the expressions 
contain back-quoted commands, then the part in back-quotes will not have 
any node names prefixed properly.

Workaround

Use namespaces when referencing or importing files. Alternatively, you can 
modify your expressions to not use MEL commands or back-quoted 
expressions. C style expressions such as “foo.x = 0.5” are treated correctly 
in references and the nodes will be correctly renamed. However, MEL style 
commands such as “setAttr foo.x 0.5” will not work correctly. 

Limitations with using prefixes for name clash resolution
When referencing a file using a renaming prefix that in turn references a file 
using a namespace, the outer renaming prefix will be turned into a 
namespace instead. 

Referencing a file into the same scene multiple times using the default 
renaming prefix will result in ambiguous references to the objects contained 
within that file. Note that referencing a file multiple times into the same 
scene can happen indirectly if a file being referenced or imported references 
that scene. 

Workaround

Use namespaces for all your file references. For import though, once you use 
namespaces, everything gets put in a namespace, whether it's clashing or 
not (even if it already has a namespace, it gets another one added on). But if 
you use prefixes, it will strip out existing namespaces, and then resolve 
clashes with prefixes. So you may wish to choose your method of clash 
resolution depending on what's in your file already. Alternatively, you can 
ensure that you assign unique rename prefixes to files that will be imported 
multiple times. You can do this by going to the File > Import options box or by 
using the -renamingPrefix flag on the file command in the Script Editor.

Problems importing and referencing the same file with the 
same prefix

There are problems with importing and referencing the same file with the 
same prefix. If the file is referenced and then imported then all is well. 
However, if the file is imported and then referenced, there are ambiguities in 
object names. Also, if the same renaming prefix is used with multilevel 
references, the resulting file may contain errors.

Workaround

Use namespaces when importing or referencing files. Alternatively, you can 
either reference the file before importing it or change the renaming prefix 
between importing and referencing. 
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Namespace or name-clash mechanisms limitation
When creating a reference in the current scene, and this reference in turn 
contains a referenced MEL script, the namespace or name-clash mechanisms 
will not be applied to any node names referred to in the script. This can 
cause problems if the MEL script relies on explicit names that are contained 
in the referenced file.

Workaround

Try to create MEL scripts that are not dependent on the actual naming of 
nodes contained in the scene. 

Can't replace nested reference 
Replacing a nested reference file (i.e., a reference which is not a child of the 
main scene) is a temporary action. The reference to the new file will not be 
saved with the main scene. 

Workaround

Open the parent file of the reference and replace it there.

Can’t save reference edits with Shared Shading Networks or 
Shared Display Layers on

If a reference is created with the Shared Shading Networks or Shared Display 
Layers options, you will not be able to Save Reference Edits to it. The menu 
item in the UI is not available, and an error will be returned when using the 
file -saveReference command. 

Changing the structure of shading networks prevents sharing
When creating references with the Shared Shading Networks option you 
should avoid changing the structure of any resulting shared shading 
networks. If nodes are added or removed from the shading network in the 
parent scene (for example, by creating a node in the parent scene and 
connecting it to one of the referenced shading network nodes), the network 
may not be correctly shared the next time a reference is reloaded.

This limitation does not apply to the modification of attributes or attribute 
values: attributes can be added or deleted, and attribute values changed.

Problems with nodes when exporting animation
The export animation flags of the file command only write out animation 
nodes. When you have animation nodes parented under other nodes which 
are not exported, Maya writes out connectAttr commands that reference 
these missing nodes. A relative path is used for these connectAttrs because 
the most common scenario is when these missing nodes actually belong to 
some other referenced file.

In cases where there are non-unique node names involved, the relative paths 
for non-exported nodes can be the same if the exported nodes are parented 
under different nodes with the same name. This creates incorrect results 
when the exported animation is re-imported to Maya. 
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Workaround

Make sure that parent (non-animation) nodes, such as locators, are uniquely 
named, or choose a way of exporting (such as export selected) that also 
exports the parented non-animation nodes.

Deleting shared reference nodes problems
In cases where there are shared reference nodes in a file, removing 
references and re-saving may result in instability and Maya closing 
unexpectedly.

Workaround

Opening the scene via the Preload Reference editor (File > Open Scene > � 
and select Selective Preload) allows you to open the file without loading the 
references. You can then delete these references. 
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RIB Export limitations
The following limitations and workarounds relate to Rib Export.

Not all Maya objects are converted by RIB plug-in
Not all Maya objects are converted by the RIB plug-in. Most notably, textures 
and particles are not converted. However, cameras, lights, geometry and their 
animation are translated correctly. A very simple algorithm maps Maya’s 
lambert, phong, and blinn shaders to their RenderMan equivalents and 
copies the color attribute. If a texture is mapped to the shader in Maya, then 
the resulting RenderMan color will be indeterminate. Also note that this 
version of the plug-in does not support per-face shading groups, thus shaders 
assigned to specific faces will not be converted, and those faces will be 
white when rendered by RenderMan.

Maya light decays and RenderMan default settings
RenderMan’s lights all have a decay of 2, which may cause illumination 
mismatches in lighting if you have your light’s decay set to anything other 
than 2 in Maya.

Workaround

Set all Maya light decays to 2.

Maya’s ambient lights are not well represented in RenderMan
Maya’s ambient lights are not well represented in RenderMan and will tend to 
wash out the RenderMan rendered scene once translated.

Workaround

Reduce the intensity of your ambient lights before translation, remove them 
altogether, or set the ambient shade parameter to 0 in Maya to better match 
the RenderMan look.

Warnings for scene written to RIB with disabled motion blur
If a scene is written to RIB with motion blur disabled, when that file is 
rendered by RenderMan it will generate warnings of the form: “R07005 
Premature RiMotionEnd”. 

Workaround

These can be safely ignored. This problem will be corrected in a future Maya 
release.
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API and Devkit limitations
The following lists limitations and workarounds for the API and Devkit for Maya 
2008. We also recommend that you read the API guide documentation before 
attempting a major project using Maya. 

It is not possible to distinguish between the color black and an 
unassigned color in an MPxHwShaderNode plug-in

There currently is no way of setting what value to use for an unassigned color 
of an MPxHwShaderNode plug-in. Currently, the color black or 0,0,0,1 is used 
as the unassigned color. 

Unable to unload an MPxNode plug-in if MPxData is specified 
If a MPxNode plug-in creates an MPxData in its initialize() method, you 
will receive a warning that the plug-in is in use when trying to unload it even if 
you have not created a node. This is because the proxy MPxData type is in 
use. 

Workaround

Do not create the MPxData until it is required in the compute() method. 

MItMeshPolygon::getColors(colorArray) does not provide access 
to all colors

There is a second parameter to the MItMeshPolygon::getColors() 
method. This parameter specifies the list of color sets that should be 
considered in the method. If not specified, this method will operate on the 
current color set. 

Workaround

Specify the list of color sets that should be considered by the 
MItMeshPolygon::getColors() method.

Plugs are deleted upon deleting or disconnecting nodes
When deleting or disconnecting nodes that are connected to other nodes, the 
plugs that are connected to the deleted or disconnected nodes gets deleted 
as well. 

Workaround

Create a new plug for every attribute. 

Attribute changed callbacks limitation
Attribute changed callbacks are not invoked if the modification to the 
attribute is made by a tool such as Move. 
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MFnDependencyNode flags limitation
MFnDependencyNode flags are not reset when they are deallocated. 
Resetting these flags requires an entire DG traversal. 

For best performance, it is better for you to control this operation since you 
may only be interested in a subset of the depend nodes in the scene. 

MFnMesh::assignUVs() does not support history
The method MFnMesh::assignUVs() does not support history. As a result, 
modifications made to UVs with this method may be overwritten as the 
dependency graph updates. 

Long names of attributes can be incorrectly re-used
It is possible to create new attributes on a node that have the same long 
name as an already existing attribute but differs by the short name. This will 
cause updating problems for the Channel Box and Attribute Editor.

API plugs and dependencies hierarchy limitation
The API does not support hierarchies of plugs and their dependencies in a 
single dependency node. Dirty propagation works correctly across 
connections between nodes, but not between internal attributes on a user-
defined node made with MPxNode. 

Workaround

Use the method attributeAffects() to “flatten hierarchies” when 
declaring their affects behavior between all inputs and outputs on your node.

OBJ files need “.obj” extension
Wavefront OBJ files need the .obj extension to be recognized automatically 
when the File > Open Scene Import option is set to Best Guess. 

Workaround

Set the Import option to OBJ to import a file without the .obj extension.

Batch rendering scenes with plug-ins
If you have a Maya scene that uses two (or more) plug-ins, both of which fail 
in their “initializePlugin” method (due to a missing license for example), and 
both plug-ins require one of the libraries OpenMayaUI, OpenMayaAnim or 
OpenMayaFX, when attempting to batch render the scene Maya may produce 
a fatal error. 

Workaround

Manually add the following lines at the end of your userPrefs.mel file.

dynamicLoad OpenMayaUI

dynamicLoad OpenMayaAnim

dynamicLoad OpenMayaFX
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Unloading and reloading plug-in
If a plug-in command is called from an expression or a MEL procedure, and 
after the expression or procedure has been parsed, the plug-in is unloaded 
(or unloaded and then reloaded), Maya may produce a fatal error if the 
expression is triggered or the procedure is re-executed. When MEL parses the 
expression or procedure, it saves a pointer to the doIt method of the plug-in 
command. The value of this pointer is not normally recalculated, so if the 
plug-in is unloaded or reloaded at a different location, the pointer is no longer 
valid. 

Similar issues will occur if MFnPlugin::registerUI() is used to register a 
command defined by a plug-in. 

Workaround

Enclose the call to the plug-in command in a MEL eval statement. This forces 
MEL to compile the statement each time the expression is evaluated or the 
procedure is run. If the plug-in has been unloaded this is detected and an 
error results. If the plug-in has been reloaded, the new location of the doIt 
method is computed during the recompile.

Custom material shader plug-in with a glow intensity attribute
If a custom material shader plug-in is implemented with a glow intensity 
attribute, this attribute will be ignored by the software renderer unless an 
internal Maya material shader in the scene (e.g. lambert, blinn, phong) has a 
glowIntensity value greater than zero. Currently the software renderer only 
queries material shader nodes that match the internal types for a 
glowIntensity value that is greater than zero. There is no way to directly 
override this limitation. 

Workaround

In order to assure the rendering of a custom shader's glowIntensity 
attribute an MSceneMessage::kBeforeSoftwareRender callback and an 
MSceneMessge::kAfterSoftwareRender callback must be registered. The 
first callback must create an internal material shader node via “shadingNode 
-asShader lambert;” and it must retrieve the node name returned. Then it 
must set that node's glowIntensity attribute to a value greater than zero. The 
second callback will simply remove this “dummy” node.

Connecting the plugs of two nodes and breaking the connection
There may be situations in which it is desirable to connect the plugs of two 
nodes and then soon after break this connection. If 
MDGModifier::connect() is used to connect geometry data between two 
nodes and if this connection is broken before the screen is refreshed the 
data will not be cached on the downstream node. 

Workaround

A call to

M3dView::active3dView().refresh();
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before disconnecting the plugs will force the dependency graph to evaluate. 
This will cause the downstream geometry node to read the input data, and 
after this evaluation the data is available for caching to the node if the 
connection is subsequently broken. 

Incomplete MPlugs
The plug passed to the user defined method that is registered with 
MNodeMessage::addAttributeAddedOrRemovedCallback() is an 
incomplete MPlug. Complex data type values will not be accessible via 
MPlug::getValue(MObject value). 

Workaround

This problem can be circumvented by using code similar to the following.

MFnDependencyNode fnDn(plug.node()); 

/*where "plug" is the name of the plug passed in as a parameter */

MString newPlugName(plug.name()); 

/* MPlug::name() will actually return a string containing the 

"nodeName.attributeName"  so it may need to be parsed for the 

following call. */

MPlug realPlug = fnDn.findPlug(newPlugName);

In the above example, “realPlug” is a fully functional and accessible MPlug.

Custom nodes with store-able internal attributes that are arrays
Custom nodes with store-able internal attributes that are arrays may display 
incorrect array indices when they are read into Maya from a scene file 
containing the node. This will be apparent in the 
MPxNode::setInternalValue() method if the number of array elements is 
compared to the plug's logical index and they are found to be equal in value. 
It is important to note that this will occur only with internal attributes. 

Type of MObject that Maya passes
The type of MObject that Maya passes to the following methods will always 
be MFn::kInvalid.

virtual MPxGeometryIterator * iterator (MObjectArray & 

componentList, MObject & component, bool useComponents)

virtual MPxGeometryIterator * iterator (MObjectArray & 

componentList, MObject & component, bool useComponents, bool 

world) const

These routines are used in classes derived from MPxGeometryData. There is 
currently no workaround for this problem. 

No hooks for creating light shader nodes
There are currently no hooks from within the API for creating light shader 
nodes with properties similar to Maya's area light node. 
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Creating a blendShape
If a blendShape is created from within the API using 
MFnBlendShapeDeformer::create(), the method 
MFnBlendShapeDeformer::addBaseObject() will fail if used with the 
MObject of a curve that was newly created using 
MFnNurbsCurve::create(). 

Workaround

A simple workaround is to locate the MDagPath of the newly created NURBS 
curve and obtain the MObject from that class. This object can be used 
successfully with addBaseObject().

Tools performing “add pick”
Tools made with MPxSelectionContext perform an “add pick” by default as 
opposed to the built in Maya selection tools which perform a “replace pick” 
by default. An “add pick” adds a selection to the active selection list while a 
“replace pick” replaces the current selection list with the selected object or 
objects. 

Workaround

Use MGlobal::displayInfo() to instruct the user to left click the mouse in 
an empty part of the scene in order to begin a new selection. 

Method setCursor()
When the method setCursor() is called with an instance of an 
MPxSelectionContext class the method will fail. The same method called 
with an instance of MPxContext will function as documented. 

Method MDrawRequestQueue::isEmpty() 
Using the method MDrawRequestQueue::isEmpty() on an instance of 
MDrawRequestQueue to which no MDrawRequests have been added will 
cause Maya to crash. 

Workaround

The method operates as documented if called on a queue to which one or 
more MDrawRequests have been added. Incorporate state checking code to 
assure that an MDrawRequest has been appended before make a call to 
isEmpty(). 

Assigning a texture shader as an input to a built-in Maya 
material shader

When a user assigns a texture shader as an input to a built-in Maya material 
shader (for example, lambert) a connection is automatically made between 
the texture node's message attribute and the downstream materialInfo 
node's texture[0] attribute. This is necessary for accurate hardware 
rendering. This does not happen automatically with custom material shaders 
and procedures will have to be implemented to make the connection. 
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Unfortunately when the scene is saved and re-opened the texture will no 
longer be connected to the materialInfo node's texture[0] attribute. Instead 
the material shader's message attribute will have this connection. 

Workaround

Procedures will have to be implemented to break this connection and 
reconnect the texture node's message attribute with the texture[0] attribute. 
Possible solutions may include: the registering of a callback in the plug-in's 
initialize method to check for this connection and alter it if necessary, or the 
modification of the AE template script to make such connections when 
necessary. 

Monitoring the desired hardware resolution of a Texture2d node
To monitor the desired hardware resolution of a Texture2d node the renderer 
queries its resolution attribute. This attribute is added dynamically to a 
texture when the user sets the Hardware Texturing >Texture Quality of a built 
in material shader node (e.g. lambert.). This is not the case with custom 
material shader plug-ins. 

Workaround

A procedure must be implemented that will dynamically add the resolution 
attribute (type kLong) to an input texture. The resolution attribute can have 
the values: 32, 64, 128, or 256.

MPxContext::doHold() method
The MPxContext::doHold() method is called on a context tool even if the 
Alt key is pressed. Ordinarily the use of the Alt key should override the 
context tool and allow exclusive use of the tumble mechanism. Instead, both 
happen simultaneously. 

Shader plug-ins and using float2 compound attributes
Shader plug-ins that make use of float2 compound attributes may 
occasionally receive incorrect data from the data block. 

Workaround

It is best to extract the data as a compound attribute, and retrieve the 
contents individually. In other words, the first example is preferred over the 
second equivalent example. 

float2& uv = block.inputValue( aUVCoord ).asFloat2(); 

float u = uv[0]; 

float v = uv[1]; 

vs. 

float& u = block.inputValue( aUCoord ).asFloat(); 

float& v = block.inputValue( aVCoord ).asFloat(); 

Coding it the second way may result in the u and v values being the same in 
certain cases.
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Calling MFnMesh::deleteFace()
A call to MFnMesh::deleteFace() will insert a deleteComponent node as 
construction history upstream from the affected mesh, however a call to 
MFnMesh::addPolygon() does not insert a corresponding construction 
history node. 

Workaround

MFnMesh::addPolygon() should only be used from within the compute 
method of a node that is placed upstream from the affected mesh object. 
Within the compute method the MFnMesh instance will act upon the 
kMeshData that is passed through as input and output data.

Querying the active view port within the API
There is no way within the API to query the active view port to find out if 
textures are currently displayed, nor is it possible to set this option. 

MPxCommand and complex data types
When writing an MPxCommand that is intended to receive arguments from the 
MEL command line, please be aware that there is no way to hand a 
command plug-in a complex data type by pointer value. 

Workaround

The class MArgList contains several methods that permit the passing of 
complex data types from the MEL command line to a plug-in command. These 
are:

MStatus get( unsigned& indexReadAndUpdate, MVector&, unsigned 

numElements=3 ) const

MStatus get( unsigned& indexReadAndUpdate, MPoint&, unsigned 

numElements=3 ) const

MStatus get( unsigned& indexReadAndUpdate, MMatrix&) const

MStatus get( unsigned& indexReadAndUpdate, MIntArray& ) const

MStatus get( unsigned& indexReadAndUpdate, MDoubleArray& ) const

MStatus get( unsigned& indexReadAndUpdate, MStringArray& ) const

MFnPluginData::create() will fail to maintain a reference to an 
MObject
MFnPluginData::create() will fail to maintain a reference to an MObject if 
the assignment is not done at the time of creation. For example this will fail: 

fnPluginDat.create(id, &stat);

MObject obj = fnPluginDat.object();

Workaround

Always assign the MObject at the time of creation so that a reference will be 
maintained internally. For example:

MObject obj  = fnPluginDat.create(id, &stat);
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MFnFreePointTriadManipulator::setSnapMode(false)
If MFnFreePointTriadManipulator::setSnapMode(false) is set to false, 
it will remain in snapMode if a single axis handle is manipulated. If the 
central handle is used the manipulator will move freely. 

Global selection list does not preserve selection order of mesh 
object components

The global selection list does not preserve selection order of mesh object 
components. For example, a tool designed to operate selected mesh vertices 
should not depend on the selection order. 

MItDependencyGraph only traverses connections that affect the 
specified starting plug or node
MItDependencyGraph only traverses connections that affect the specified 
starting plug or node. Therefore, it may not traverse some connected nodes, 
such as connections to message attributes or dynamic attributes. Also, 
connections to a transform node's translate, rotate, scale attributes will not 
be found if traversing upstream through the worldMatrix output. Additionally, 
since AnimUtil::isAnimated() relies on MItDependencyGraph for its 
functionality, it will not find animCurves connected to the translate, rotate or 
scale if getting there requires traversing the transform node's worldMatrix 
attribute. 

Workaround

When using MItDependencyGraph, when a transform node or message plug 
is reached, prune the current iteration and start another 
MItDependencyGraph. When using MAnimUtil::isAnimated(), when a 
transform node or message plug is reached, call MAnimUtil::isAnimated() 
again.

Invoking the objExists MEL command limitation
Invoking the objExists MEL command with MGlobal::executeCommand() 
during the retrieval of a scene file can produce incorrect results.

MArgDatabase::getFlagArgument() and 
MArgParser::getFlagArgument() usage limitation

The methods MArgDatabase::getFlagArgument() and 
MArgParser::getFlagArgument() require that numbers larger than 2^31 be 
enclosed in quotes. 

MPxSurfaceShape related problems
The following lists MPXSurfaceShape related problems.

User defined shapes created with MPxSurfaceShape
User defined shapes created with MPxSurfaceShape cannot support per-
components texturing or shading. 
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Maya Help limitations

Microsoft Internet Explorer blocks help content (Windows)
The Maya Help for Autodesk Maya uses JavaScript, which Microsoft Internet 
Explorer blocks by default for HTML pages on My Computer.

By default, each time the help is accessed from My Computer, you see a 
security warning message asking you if you want to show active content. 
Clicking on the message and selecting Allow Blocked Content allows the page 
to load.

To turn off this message permanently:

Within Internet Explorer, go to Tools > Internet Options, click the Advanced 
tab, and scroll down to the Security section. Turn on “Allow active content to 
run in files on My Computer.” 

Microsoft Internet Explorer shows a warning about an ActiveX 
control (Windows)

When you have registered the browser plug-in COM object on Windows (see 
”Install the Maya Web browser plug-in” on page 33 in the Basics guide) 
loading the Maya Help system from My Computer may show the following 
warning:

“An ActiveX control on this page might be unsafe to interact with other parts 
of this page. Do you want to allow this interaction?”

Click Yes to continue loading the help page.

Maya Help index loads slowly on Internet Explorer
The Maya Help index loads very slowly in Internet Explorer. This is a known 
issue when dealing with very large help systems, and is under investigation 
from the online help vendor.

Essential skills movies require QuickTime 7.1 or later
Please upgrade your version of QuickTime if you experience any problems 
viewing the movies.

Essential skills movies do not playback normally across 
network with QuickTime 7 for Windows

The Essential skills movies may not playback consistently if Maya is 
accessed across a network when using QuickTime 7 for Windows. The 
movies will playback normally if Maya is installed on your computer’s hard 
drive. This was a known issue with Apple QuickTime 7 for Windows when 
Maya 7 was shipped.
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Essential Skills Movies caption text may not appear at the 
beginning of a movie when played on Windows

The caption text that normally appears at the bottom of the Essential Skills 
Movies may not appear at the beginning of the movie on Windows computers 
when the movie is first launched if the QuickTime Player options are set to 
automatically play the movie when opened. This issue appears to only occur 
on Windows.

Workaround

On Windows computers, do the following in your QuickTime Player:

Select Edit > Preferences > Player preferences, and turn off Automatically 
play movies when opened.

Select Edit > Preferences > QuickTime Preferences, select the Browser tab, 
and turn off Play Movies Automatically.

Essential Skills Movies caption text may appear incorrect on 
Windows when the codepage setting and language setting for 
the movie are mismatched

The text captions for the Essential Skills movies may appear incorrectly when 
played back on Windows computers when the codepage setting and language 
setting for the movie are mismatched. For example, when playing back a 
movie with the movie’s language set to Chinese, on a computer whose 
codepage setting is Japanese, the Chinese caption text may appear 
incorrectly. The audio works correctly in all cases. This was a known 
limitation with Apple QuickTime 7 when Maya 8.5 was shipped.

Workaround

Play back movies in the language for which your computer is currently set.

Installing to a path with Japanese or other multibyte characters 
may prevent the Maya Help from loading

If you install to Maya and the Maya docs to a path that contains Japanese or 
other multibyte characters, you may encounter problems loading the Maya 
Help, depending on your browser.

Workaround

Install the documentation to a path with no multibyte characters and use the 
Window > Settings/Preferences > Preferences > Help > Help Location to 
point Maya to the new help location using the Remote help option. 
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